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Corporation. 
All other trademarks are the property of their respective holders and are hereby 
acknowledged. 

This product is warranted in accordance with the product license. The product’s 
performance may be affected by system configuration, the application being 
performed, operator control, maintenance, and other related factors. Rockwell 
Automation is not responsible for these intervening factors. The instructions in 
this document do not cover all the details or variations in the equipment, 
procedure, or process described, nor do they provide directions for meeting every 
possible contingency during installation, operation, or maintenance. This 
product’s implementation may vary among users. 

This document is current as of the time of release of the product; however, the 
accompanying software may have changed since the release. Rockwell 
Automation, Inc. reserves the right to change any information contained in this 
document or the software at any time without prior notice. It is your responsibility 
to obtain the most current information available from Rockwell when installing or 
using this product. 

Rockwell Automation maintains current product environmental information on its 
website at http://www.rockwellautomation.com/rockwellautomation/about-
us/sustainability-ethics/product-environmental-compliance.page. 

Customer Support Telephone — 1.440.646.3434 

Online Support — http://www.rockwellautomation.com/support/ 
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Chapter 1 

Overview 

FactoryTalk Historian Site Edition (SE) provides the capability 
to collect, store, analyze, and visualize data using a powerful 
engine and a set of reporting tools such as time-series trends, 
bar charts, pie charts, Pareto charts, tabular trends, and a method 
of generating reports using Microsoft Excel. It also uses 
compressed-storage data algorithms to contain a vast amount of 
data in a small format. 

NOTE For the up-to-date information on the product, refer
to the Release Notes. 

FactoryTalk Historian SE is closely integrated with FactoryTalk 
Security and the following Rockwell Automation applications: 

Application Description 

FactoryTalk 
Live Data 
(FTLD) 

A direct data interface to FTLD delivers native 
FTLD data directly to FactoryTalk Historian SE 
without requiring intermediate interfaces and 
standards such as OPC. 

FactoryTalk 
Directory 

FactoryTalk Historian SE uses FactoryTalk 
Directory to look up data points for configuring 
points to historize. The FactoryTalk Directory is 
also used for auto-discovering controller data 
sources and tags in the initial configuration 
process. 

FactoryTalk 
Activation 

FactoryTalk Historian SE is activated by Rockwell 
Automation's central licensing system based on 
the FactoryTalk Activation Server. 
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Application Description 
FactoryTalk 
Diagnostics 

Because of a close integration of FactoryTalk 
Historian SE with FactoryTalk Diagnostics, all 
system and diagnostics messages from 
FactoryTalk Historian SE are centrally stored and 
maintained in the FactoryTalk Diagnostics 
database. 

FactoryTalk 
Audit 

All FactoryTalk Historian SE Server auditing 
messages are stored and available in the 
FactoryTalk Audit database. 

FactoryTalk 
View SE 
Trending 

FactoryTalk View Site Edition natively trends data 
from FactoryTalk Historian SE. 

FactoryTalk 
Historian 
Machine 
Edition (ME) 

FactoryTalk Historian ME provides a Data Transfer 
service to allow its logged data to be transferred 
to the FactoryTalk Historian SE for long-term 
storage and analysis. 

FactoryTalk 
VantagePoint 

The data from multiple FactoryTalk Historian SE 
Servers and FactoryTalk Historian ME Servers can 
be brought together into a single information 
management and decision support system using 
FactoryTalk VantagePoint. 

FactoryTalk 
Batch 

The event journal data from your FactoryTalk 
Batch system can be collected through the 
FactoryTalk Batch Interface and stored within 
FactoryTalk Historian SE. 

The FactoryTalk Historian SE installation media contain the 
following software products: 

• FactoryTalk Services. The set includes:

• FactoryTalk Services Platform with FactoryTalk
Directory

• FactoryTalk Activation Manager

FactoryTalk Historian 
installation package 
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• FactoryTalk Linx

• FactoryTalk Historian Asset Framework. This set includes
FactoryTalk Historian System SE Explorer.

• Microsoft SQL Server Express

• FactoryTalk Historian SE. The set includes:

• FactoryTalk Historian Server

• FactoryTalk Historian Live Data Interface

• FactoryTalk Historian Analysis Service

• FactoryTalk Historian Management Tools

• FactoryTalk Historian Notifications Service

The following diagram shows a typical architecture of the 
FactoryTalk Historian SE environment. 

Typical architecture 
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The machines shown in the drawings adopt the following roles: 



Overview Chapter 1 

Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 15 

Role Description 

FTHSE Server A computer with the following components installed: 
Required: 

• FactoryTalk Services, including FactoryTalk Activation Manager
• Microsoft SQL Server Express (required for Asset Framework)
• FactoryTalk Historian Asset Framework Server
• FactoryTalk Historian Analysis Service (optional)
• FactoryTalk Historian SE Server
• FactoryTalk Historian Notifications Service (optional)

Optional: 
• FactoryTalk Directory

Note: Alternatively, FactoryTalk Directory may be installed on a separate computer. 
FTHSE 
Interface / 
Data Server 

A computer with the following components installed: 
• FactoryTalk Services, including FactoryTalk Activation Manager (optional)
• Data server (FTL, RSLC, FTVSE Server, or a third-party OPC Server)

Note: FactoryTalk Linx is a part of the FactoryTalk Services installation.
• FactoryTalk Historian Live Data Interface

FT 
VantagePoint 
Server 

A computer with the following components installed: 
• FactoryTalk Services, including FactoryTalk Activation Manager
• Microsoft SQL Server (required for VantagePoint)
• FactoryTalk VantagePoint EMI Server

For installation and configuration steps, refer to the FactoryTalk VantagePoint 
Getting Results Guide, available on the FactoryTalk VantagePoint installation DVD. 

This document assumes that the FTVP Server will be installed on its own computer. If 
you have a small application and you want to install the FTVP Server on the same 
computer as the FTHSE server, refer to KB article 62869 for installation and 
configuration details. 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/62869
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Role Description 
FT Clients Computers with the following components installed: 

• FactoryTalk Services, including FactoryTalk Activation Manager (optional)
• Any of the following clients:

o FactoryTalk Historian ActiveView
o FactoryTalk Historian BatchView
o FactoryTalk Historian DataLink
o FactoryTalk Historian ProcessBook
o FactoryTalk View SE (Server, Studio, Client or Network Station).

This client requires the Historian Connectivity option, which is a part of the 
FactoryTalk View installation media. 

o FactoryTalk VantagePoint Client

FTVP clients (Trend, Excel Add-in, or Portal) are not covered in this document 
because they are web-based clients and their necessary components are 
downloaded through your web browser. 

Engineering 
Workstation 

A computer with the following components installed: 
• FactoryTalk Services, including FactoryTalk Activation Manager to function

as the FactoryTalk Activation Server
• FactoryTalk Historian SE Management Tools
• FactoryTalk VantagePoint Dashboard Builder

This computer is used for the administration of your FTHSE Server. The tasks that 
may be performed on this computer include: 

• Assigning FTHSE activations.
• Creating points using the auto-discovery feature, searching individual points,

using the Excel Tag Configurator.

The hardware required with FactoryTalk Historian Site Edition 
depends on the demands an application places on the system. 
The greater the demand, the more powerful system is required. 
In any application, faster processors and more memory will 
result in better performance. In addition, there should always be 
sufficient disk space to provide virtual memory that is at least 
twice the size of the physical memory. 

System requirements 
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For current information on the system requirements for the 
individual Historian SE suites, refer to the FactoryTalk 
Historian SE Release Notes. 

The user documentation on FactoryTalk Historian SE is divided 
into individual suites, as presented in the following table.  

TIP If the PDF file does not open properly, disable 
Protected Mode in Adobe Reader (Edit > 
Preferences > Security (Enhanced) and uncheck 
the Enable Protected Mode at startup 
checkbox). 

Legend: 

AF: FactoryTalk Historian Asset Framework  

AS: FactoryTalk Historian Analysis Service 

LDI: FactoryTalk Historian Live Data Interface  

MT: FactoryTalk Historian SE Management Tools 

Server: FactoryTalk Historian SE Server 

These documents Are available in these 
suites 
Server MT AF AS LDI 

root folder: 
AuditingthePIServer.pdf 
AutidtViewer.chm 
Buffering-User-Guide_EN.pdf 
FTHistorianConfig.chm 
FTHistorianSERN.chm 
FT Historian SE Installation Assistant.pdf 

x 
x 
x 
x 
x 
x 

x 
x 
x 
x 
x 
x 

x 
x 

x 
x 

x 
x 
x 
x 

User documentation 
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These documents Are available in these 
suites 
Server MT AF AS LDI 

FT Historian SE Installation and Configuration Guide.pdf (this document) 
FT Historian SE Live Data Interface User Guide.pdf 
High-Availability-Administrator-Guide_EN.pdf 
PI-AF-2018-SP3-Patch-2-Release-Notes.htm 
PI-AF-Database-Upgrade.pdf 
PI-AF-2018-R2-Services-Installation-and-Upgrade-Guide-EN.pdf 
PI-AuditViewer-2016-R2-Release-Notes.pdf 
PI-Builder-2018-SP3-Patch-2-User-Guide-EN.pdf 
PI-Data-Archive-2018-SP3-Applications-Guide-EN.pdf 
PI-Data-Archive-2018-SP3-Installation-and-Upgrade-Guide-EN.pdf 
PI-Data-Archive-2018-SP3-Reference-Guide_EN.pdf 
PI-Data-Archive-2018-SP3-Security-Configuration-Guide-EN.pdf 
PI-Data-Archive-2018-SP3-Release-Notes.pdf 
PI-Data-Archive-2018-SP3-System-Management-Guide-EN.pdf 
PI-Interface-Configuration-Utility-(PI-ICU)-1.5.1-User-Guide.pdf 
PI-Server-2018-SP3-Patch-1-Installation-and-Upgrade-Guide-EN.pdf 
PI-MDB-to-PI-AF-Transition-Guide_EN.pdf 
PISQLCommanderLite.chm 
PI-System-Explorer-2018-SP3-User-Guide-EN.pdf 
PI-SMT-2018-SP3-Patch-1-Release-Notes.html 
PI-Universal-Interface-(UniInt)-Framework-4.7.0-User-Guide.pdf 

x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 

x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 
x 

x 

x 
x 
x 
x 

x 

x 
x 

x 

x 

x 

x 
x 
x 

x 

x 
x 

x 
subfolder Advanced Server Options: Server MT AF AS LDI 
PI_OPC_DA_Interface_Failover_Manual_2.3.20.9.docx  
PI-ACE-2010-R2-SP2-Release-Notes.pdf  
PI-ACE-2010-R2-User-Guide-for-Visual-Basic-.NET_EN.pdf 
PI-ACE-2010-R2-User-Guide-for-Visual-Basic-6_EN.pdf 
PI-Interface-for-OPC-DA-2.7.0-User-Guide.pdf 
PI-JDBC-2019-Release-Notes.htm 
PI-JDBC-Driver-2019-Administrator-Guide.pdf 
PI-ODBC-2016-R2-Administrator-Guide.pdf 
PI-ODBC-2016-R2-Release-Notes.pdf 
PI-OLEDB-Enterprise-2019-Patch-1-Release-Notes.pdf 

All 
documents 
included. 
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These documents Are available in these 
suites 
Server MT AF AS LDI 

PI-OLEDB-Enterprise-2019-User-Guide.pdf 
PI-OLEDB-Provider-2019-Patch-1-Release-Notes.pdf 
PI-OLEDB-Provider-2019-User-Guide.pdf 
PI-OPC-DA-Server-2018-Patch-1---Release-Notes.docx 
PI-OPC-DA-Server-2018-Patch-1-User-Guide.pdf 
PI-SQL-Client-ODBC-2018-R2-and-Oracle-Database-Gateway-
Configuration-Guide.pdf 
PI-SQL-Data-Access-Server-(RTQP-Engine)-2018-SP3-Administrator-
Guide.pdf 
PI-SQL-Data-Access-Server-(RTQP-Engine)-2018-SP3-Release-Notes.pdf 
subfolder Advanced Server Options > OPC HDA Server: Server MT AF AS LDI 
Buffering-User-Guide-EN.pdf 
DCOM_Configuration_Guide_2.4.4.pdf 
PI_HDAServerConfigTool_ReleaseNotes.txt 
PI_HDATool_1.1.0.0_ReleaseNotes.txt 
PI_HDATool_1.1.0.0_UserGuide.docx 
PI-API-1.6.9-Release-Notes.htm 
PI-Buffer-Subsystem-2018-SP2-Patch1-Release-Notes.pdf 
PI-OPC-HDA-Server-2016_Release-Notes.docx 
PI-OPC-HDA-Server-2016_User-Manual.docx 
PISDK-2018SP1-Patch-1-ReleaseNotes.pdf 

All 
documents 
included. 

subfolder MCN Health Monitor: Server MT AF AS LDI 
IT-Organizer.doc 
MCNHealthMonitor_1.3.5.2.doc 
MCN-Quick-Start-Guide.doc 
PI_PIPerfMon_2.1.0.88.pdf 
PI_PIPing_2.0.0.20.docx 
PI_PISNMP_1.5.1.306.docx 
PI_TCPResponse_1.1.6.0.doc 

All 
documents 
included. 
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The user documentation is available in the following locations: 

• On the installation media (page 20)

• On the local hard drive (page 21)

• In the Start menu (page 21)

There are the following locations on the FactoryTalk Historian 
SE installation media with the user documentation and 
documentation-related resources: 

• The Install FactoryTalk Historian Site Edition > Open
Installation Instructions > Installation Instructions
page
On this page you will find the following resources:

• FactoryTalk Historian SE Installation Assistant

• FactoryTalk Historian SE Installation and
Configuration Guide

• Adobe Reader required to open PDF files.

• The Install FactoryTalk Historian Site Edition > Read
Documentation > Documentation page
On this page you will find the following resources:

• FactoryTalk Historian SE Installation and
Configuration Guide

• Historian SE Reference Guide

• FactoryTalk Historian Live Data Interface User Guide

• Historian SE Introduction to System Management
Guide

• FactoryTalk Historian SE Release Notes

• Adobe Reader required to open the PDF files.

• A link to the Redist\Docs folder on the installation
media that stores all the user documentation.

Location of the user 
documentation 

On the installation 
media 
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• A link to the Rockwell Automation Literature Library
(http://literature.rockwellautomation.com/idc/groups/pu
blic/documents/webassets/browse_category.hcst).

To access the user documentation available on your computer, 
go to the following locations: 

• On a 32-bit operating system:
C:\Program Files\Common Files\Rockwell\Help

• On a 64-bit operating system:
C:\Program Files (x86)\Common Files\Rockwell\Help

The Help folder contains one or more of the following 
subfolders, representing individual FactoryTalk Historian suites: 

• FactoryTalk Historian SE <version> Analysis Service

• FactoryTalk Historian SE <version> Server

• FactoryTalk Historian SE <version> Management Tools

• FactoryTalk Historian SE <version> Asset Framework

• FactoryTalk Historian SE <version> Live Data Interface

Depending on the suite, the subfolders listed above may also 
contain the Advanced Server Options and/or the MCN Health 
Monitor folders. 

For details on the division of the user documentation for the 
individual suites, see "User documentation (page 17)". 

Depending on which suite you have installed on your computer, 
the Start menu or the Start screen will contain one or more of 
the following links: 

• FactoryTalk Historian SE Analysis Service documentation

On the local hard drive 

In the Start menu 

http://literature.rockwellautomation.com/idc/groups/public/documents/webassets/browse_category.hcst
http://literature.rockwellautomation.com/idc/groups/public/documents/webassets/browse_category.hcst
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• FactoryTalk Historian SE Server documentation

• FactoryTalk Historian SE Management Tools
documentation

• FactoryTalk Historian SE Asset Framework
documentation

• FactoryTalk Historian SE Live Data Interface
documentation

The links refer to the user documentation folders detailed in 
"User documentation (page 17)". 
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Chapter 2 

Pre-installation tasks 

Before you install FactoryTalk Historian SE, do the following: 

• Synchronize time settings on Historian system computers
(page 23).

• Disable the Windows time zone (page 24).

• Learn about installation-related recommendations (page
24).

• Learn about product compatibility for installing or
upgrading FactoryTalk Historian Suites (page 24).

For all machines that are part of the FactoryTalk Historian 
system, you must ensure that the time is set correctly and 
synchronized with the FactoryTalk Historian server. In addition, 
make sure that all Windows machines have the proper time-
zone settings and that they are set to automatically adjust for 
daylight-saving changes. 

The clocks of the FactoryTalk Historian server computer and 
client computers should all be synchronized. This is typically 
done through the domain controller. The domain controller's 
time is synchronized first by an NTP source. Then, the domain 
controller synchronizes all other computers that are a part of the 
FactoryTalk Historian system. 

For details, search the Rockwell Automation Technical Support 
(http://rockwellautomation.custhelp.com/) web site for daylight 
saving time. 

Synchronize time 
settings on FactoryTalk 
Historian system 
computers 

http://rockwellautomation.custhelp.com/
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The Windows time zone (TZ) environment variable adversely 
affects the Historian server. You must ensure that TZ is not set 
on the Historian server computer. 

To confirm that the TZ variable is not set on your Windows 
machine: 

1. Display your systems Properties dialog (for example,
through the Start menu or by right-clicking on the
computer icon and selecting Properties).

2. Click Advanced system settings.
3. Click Environment Variables.
4. If the TZ variable is present, delete it.
5. Restart the computer, if prompted.

We recommend that you use the default installation options. 

If you want to use the SMT software installed on a FactoryTalk 
Historian SE server computer to manage a FactoryTalk 
Historian Live Data Interface installed on another computer, 
you must log on to both computers with the same user name. 
(The user must have administrator privileges on both 
computers.) 

When upgrading your FactoryTalk Historian SE system to 
version 7.00, all FactoryTalk Historian SE suites need to be 
upgraded. This includes the FactoryTalk Historian SE, 
FactoryTalk Historian Asset Framework, FactoryTalk Historian 
Analysis Service, FactoryTalk Historian Live Data Interface, 
and FactoryTalk Historian SE Management Tools. 

There may be rare times when it is not possible to upgrade the 
remote Live Data interfaces at the same time as the rest of the 
FactoryTalk Historian SE system. In such cases it is possible to 
use Live Data interfaces in versions from 3.0 to 4.01 with the 
FactoryTalk Historian SE 7.00.00 Server. 

Disable the Windows 
time zone (TZ) 
environment variable 

Learn about 
installation-related 
recommendations 

Learn about product 
compatibility for 
installing or upgrading 
FactoryTalk Historian 
suites 
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If you decide to use this mixed configuration, you need to be 
aware of the following limitations: 

• The enhanced security between the FactoryTalk
Historian Live Data Interface and FactoryTalk
Administration Console or FactoryTalk View Studio
only exists when 7.00 components are installed on both
computers (the Data Server and the Engineering
Workstation).

• The FactoryTalk Historian Live Data Interfaces in
versions from 3.0 to 4.01 do not contain the new buffer
system and do not leverage the increased throughput that
the FactoryTalk Historian SE 7.00.00 Live Data Interface
has.

• The FactoryTalk Historian SE administration (such as
creating points or configuring interfaces) should be
performed only on either the FactoryTalk Historian SE
7.00.00 Server or the Engineering Workstation with
FactoryTalk Historian SE 7.00.00 Management Tools
installed.

• If you administer FactoryTalk Historian SE on the
computers with the older versions (from 3.0 to 4.01) of
FactoryTalk Historian Live Data Interfaces installed, in
particular from within the FactoryTalk Administration
Console or FactoryTalk View Studio, the applications
will crash
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Chapter 3 

Installing FactoryTalk Historian 

NOTE Before you install any components of
FactoryTalk Historian SE, refer to the Release 
Notes for the up-to-date information on the 
installation procedures. 

In this section you will find instructions on how to install the 
following core components of FactoryTalk Historian SE: 

• Microsoft SQL Server (page 27)

• FactoryTalk Services (page 28)

Microsoft SQL Server is a requirement for running FactoryTalk 
Historian Asset Framework. 

This version of FactoryTalk Historian SE supports Microsoft 
SQL Server Express and Standard Editions. SQL Server 
Express Edition is available on the FactoryTalk Historian SE 
installation media. If you choose to use the SQL Standard 
Edition, please acquire appropriate Client Access Licenses 
(CAL) and/or processor licenses from Microsoft. For more 
information, refer to the Microsoft site 
(http://www.microsoft.com/sqlserver/en/us/get-sql-server/how-
to-buy.aspx). 

NOTE For information on supported versions of SQL Server,
see the FactoryTalk Historian SE Release Notes 
and/or the Rockwell Automation Product 
Compatibility and Download Center 
(http://www.rockwellautomation.com/rockwellautom
ation/support/pcdc.page). 

Install Core 
components 

Install Microsoft SQL 
Server 

http://www.microsoft.com/sqlserver/en/us/get-sql-server/how-to-buy.aspx
http://www.microsoft.com/sqlserver/en/us/get-sql-server/how-to-buy.aspx
http://www.rockwellautomation.com/rockwellautomation/support/pcdc.page
http://www.rockwellautomation.com/rockwellautomation/support/pcdc.page
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If you already have an SQL Server, you will be able to point to 
it during the installation of FactoryTalk Historian Asset 
Framework. 

NOTE If you want to install the Asset Framework SQL
database only, you need to run the installation 
on the machine with the Microsoft SQL Server 
installed. 

To install Microsoft SQL Server 2016 Express: 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Asset Framework > Install Microsoft SQL
Server 2016 Express.

3. Follow the on-screen instructions to complete the process.

NOTES • For more information on installing Microsoft
SQL Server 2016 Express, refer to the 
product documentation. 

• We recommend that you use the default
settings during the installation of Microsoft
SQL Server Express

4. Restart the computer, if prompted.

When you select this option, the following components will be 
installed: 

• FactoryTalk Services Platform with FactoryTalk Directory
(required - this component is installed by default)
FactoryTalk Services Platform is an underlying
architecture and a set of common services (such as
diagnostic messages, health monitoring services, access to
real-time data, and shared plant resources such as tags and
graphic displays) that Rockwell Automation products
build upon. It is a prerequisite for all FactoryTalk-enabled
software products.

Install FactoryTalk 
Services 
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• FactoryTalk Activation Manager
FactoryTalk Activation Manager allows you to download
activation files using an Internet connection, and transfer
the activation files to a computer that does not have an
Internet connection. Install this software on the same
computer as the FactoryTalk Directory server.

• FactoryTalk Linx
FactoryTalk Linx is a FactoryTalk Live Data server and a
device-based alarm and event server. FactoryTalk Linx
links Allen-Bradley networks and devices to Microsoft
Windows products such as the FactoryTalk View SE (HMI
software) and the RSLogix family of device programming
software. FactoryTalk Linx provides FactoryTalk
Historian SE with the data points (tags) it collects from
Rockwell Automation controllers.

NOTE It is recommended to install FactoryTalk Linx
(Data Server) on the same machine as 
FactoryTalk Historian Live Data Interface, 
remote from the FactoryTalk Historian SE 
server. 

• FactoryTalk Alarms and Events (optional)
FactoryTalk Alarms and Events provide a common,
consistent view of alarms and events throughout a
FactoryTalk system.

For more information on FactoryTalk, refer to FactoryTalk 
Help. 

NOTE Make sure to install FactoryTalk Services on all
computers, including the computer that will serve as 
the FactoryTalk Directory. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 
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To install FactoryTalk Services: 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Services > Install FactoryTalk Services
and follow the screenshots listed:

3. 

4.
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NOTE FactoryTalk Alarms and Events is not used in the
FactoryTalk Historian SE installation. 

5. Follow any on-screen instructions.

TIP You may omit restarting the computer after the 
FactoryTalk Services installation is complete. 

This configuration points your client computer to the 
FactoryTalk Directory server computer. Once your computer is 
connected to the FactoryTalk Directory server, you can use the 
client computer to administer the Network directory on the 
FactoryTalk Directory server computer. Also, the FactoryTalk 
Administration Console window on your client computer 
reflects the content of the Network Directory server computer. 

To specify the FactoryTalk Directory server location: 

1. Run the FactoryTalk Historian SE installation media.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Services > Specify FactoryTalk Directory
Server Location.
The FactoryTalk Directory Server Location Utility
dialog box appears.

3. Identify the computer that hosts the FactoryTalk Directory
server.

• If it is the current computer (localhost), click OK.

• If it is a remote computer, point to the proper
FactoryTalk Directory computer:

Locate the FactoryTalk 
Directory server 
computer 
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4. 
In the User name box, type the account username with 
which you will log on to the FactoryTalk Directory 
computer. 
In the Password box, type the password to the account 
with which you will log on to the FactoryTalk Directory 
computer. 
Click OK. 

5. In the Browse for Computer dialog box, select the
machine that hosts the FactoryTalk Directory, and then
click OK.
The name of the machine appears in the FactoryTalk
Directory Server Location Utility dialog box.

6. Click OK.
7. In the message box informing you that you will need to

restart the computer, click OK.
8. In the Log On to FactoryTalk (New Server) dialog box,

type the user name and password to the newly selected
FactoryTalk Directory machine.

9. Click OK. The system connects to the FactoryTalk
Directory server.

10. In the message box prompting you to restart the computer,
click No.

NOTE On the computers that have FactoryTalk
Services installed, you can open the Specify 
FactoryTalk Directory Server Location 
Utility dialog box also from the Start menu. 
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In this section you will find instructions on how to install the 
following suites of FactoryTalk Historian SE: 

• FactoryTalk Historian Asset Framework (page 33)

• FactoryTalk Historian SE server (page 44)

• (Optional) FactoryTalk Historian Live Data Interface
(page 47)
Applicable only to the customers who want to install the
interface on a remote computer.

• (Optional) FactoryTalk Historian SE Management Tools
(page 50)
Applicable only to the customers who want to administer
the FactoryTalk Historian SE server from a remote
computer.

• FactoryTalk Historian Analysis Service (page 53)

• (Optional) Additional Historian components (page 57)

Before you install FactoryTalk Historian SE, note the following: 

• To install FactoryTalk Historian SE, use a local
Administrator account or any other account that is a
member of the Domain Admins group.

• As a best practice, we suggest that you install the
FactoryTalk Historian Live Data Interface on a remote
computer.

• The Structured Exception Handling Overwrite Protection
(SEHOP) mechanism is enabled for all executable files in
the FactoryTalk Historian SE suites.

When you select this option FactoryTalk Historian Asset 
Framework Server will be installed. 

FactoryTalk Historian Asset Framework (AF) is a 
prerequisite for installing FactoryTalk Historian SE. AF 

Install FactoryTalk 
Historian suites 

Install FactoryTalk 
Historian Asset 
Framework 
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replaces the Historian module database (MDB). Over time, 
Rockwell Automation will transform MDB applications into AF 
applications. To provide backward compatibility, FactoryTalk 
Historian SE copies the contents of Historian MDB over to AF, 
in a process called transition. After the migration, the Historian 
server constantly synchronizes the MDB content with AF, 
allowing you to access MDB content from AF clients as well as 
MDB clients. Similarly, you can access AF content from MDB 
clients, as well as AF clients. This allows you to access your AF 
content with MDB-based tools, such as ACE, or with an AF 
client such as FactoryTalk Historian System Explorer. 

The complete configuration of FactoryTalk Historian Asset 
Framework consists of the following components: 

• The AF Application service

• The database scripts used to create the AF SQL database

• The Microsoft SQL server

The AF components are installed during the installation of 
FactoryTalk Historian Asset Framework. The Microsoft SQL 
server is provided as a separate component on the FactoryTalk 
Historian SE installation media. It is required by the AF SQL 
database. 

See "Install Microsoft SQL Server (page 27)" for details. 

The database scripts and the Microsoft SQL server must always 
be installed on the same computer to ensure the successful 
creation of the AF SQL database. 

The AF Application service and the FactoryTalk Historian SE 
server may be installed on the same or separate computers, 
depending on one of the topologies that you choose: 
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One computer (all-in-one) 

Two computers 

Three computers 

The all-in-one installation is the default one. If you are using a 
Historian server collective or will be creating large numbers of 
AF elements, install FactoryTalk Historian Asset Framework 
and the SQL server on a computer separate from the Historian 
server. For more information, refer to the section on 
FactoryTalk Historian Asset Framework system requirements in 
the FactoryTalk Historian SE Release Notes. 
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NOTE Before installing FactoryTalk Historian Asset
Framework, learn about the installation options it 
offers. See "Installation modes for FactoryTalk 
Historian Asset Framework (page 36)" for more 
information. 

During the installation process, you can decide how the AF 
service and the AF SQL database will be installed on your 
computer, by choosing one of five installation modes 
representing the following scenarios: 

• Both the service and the database are located on the same
computer:

Installation mode Description 

(1) AF Application Service and AF
SQL Database

The service and the database are installed on the same computer. 
This is the default setting. 

(2) AF Application Service and
AF SQL Database with
unprocessed database scripts

The service is installed on the computer, the system is prepared for 
the database installation, and the database scripts are copied to the 
following location in the Program Files directory: Rockwell 
Software\FactoryTalk Historian\PIPC\AF\SQL. 
You must process the provided scripts yourself to create the 
database. See "Manually create or upgrade the AF SQL Database 
(page 71)" for more information. 

• The service and the database are located on different
computers:

Installation mode Description 

(3) AF Application Service Only the service is installed on the computer. 
(4) AF SQL Database Note: This option must be executed on the computer with the 

Microsoft SQL Server installed. 
Only the database is installed on the computer. 
If you select this option, the database scripts will be copied to the 
computer and executed during the installation. This will result in 
creating the PIFD Asset Framework SQL database. 

Installation modes for 
FactoryTalk Historian 
Asset Framework 
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Installation mode Description 
(5) AF SQL Database with
unprocessed database scripts

Note: This option must be executed on the computer with the 
Microsoft SQL Server installed. 
The system is prepared for the database installation, and the 
database scripts are copied to the following location in the 
Program Files directory: Rockwell Software\FactoryTalk 
Historian\PIPC\AF\SQL. 
You must process the provided scripts yourself to create the 
database. See "Manually create or upgrade the AF SQL Database 
(page 71)" for more information. 

You may choose to create the AF SQL database manually using 
the provided scripts, for example, when the configuration of 
your SQL server does not allow for the integrated Windows 
authentication. During the execution of the database scripts you 
can provide the user name and the password to the SQL Server. 

Before you begin: 

• FactoryTalk Historian Asset Framework must be installed
on a computer that runs one of the following Microsoft
Windows Server operating systems:

• Microsoft Windows Server 2019

• Microsoft Windows Server 2016

• Microsoft Windows Server 2012 Standard R2 64-bit

• If you choose the installation mode other than (3) AF
Application Service, you need to run the installation on
the computer with Microsoft SQL Server installed.

TIP You can also install the SQL server later and edit 
the computer and instance names in the 
AFService.exe.config file. See "Modify the AF 
application service connect string (page 74)" for 
details. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

Install the FactoryTalk 
Historian Asset 
Framework server 



Chapter 3 Installing FactoryTalk Historian 

 

38 Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 

To install the FactoryTalk Historian Asset Framework 
server: 

NOTE During the installation, the AFServers user group may
be created. 

TIP The following instruction illustrate typical installation 
or upgrade steps. Individual steps may differ though, 
depending on the actual system configuration. 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Asset Framework > Install
FactoryTalk Historian AF Server.

3. 
The installation of the required version of Microsoft® 
.NET Framework is performed during the installation of a 
FactoryTalk Historian SE suite under certain conditions 
and has a significant impact on the upgrade process of 
FactoryTalk Historian SE suites. For details, see “About 
installing Microsoft® .NET Framework” (page 58). If you 
do not have the required version of Microsoft .NET 
Framework installed on your system, a message appears 
indicating this. 

NOTE If you click Cancel, the installation will be aborted due
to the supported Microsoft .NET Framework not 
being installed. 

If you are installing the product on Microsoft Windows 
Server 2012 R2 you may be asked to install the Microsoft 
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April 2014 update rollup. Follow the instructions in the 
message to install the rollup. 
The installation process begins. 

4. Depending on your system configuration, a message may
appear during the installation process asking you to close
certain programs.
Click Yes to continue with the installation.

You may be prompted to restart the computer once the 
installation of Microsoft .NET Framework is finished: 
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5. 
6. In the welcome screen of the Asset Framework Suite

installation wizard, click Next.
7. In the License agreement screen, accept the license

agreement and click Next.
8. In the Review Component Installation screen, verify that

the components you want installed are listed and click
Next.

9. In the Destination Drive screen, select the drive where you
want AF to be installed and click Next.
If there is not enough free space available on the drive, a
warning message will appear below the Installation drive
list. In such a case, select another drive or increase the
available space on the drive you have originally selected.
For more information on disk space requirements, see the
FactoryTalk Historian SE Release Notes.

TIP You can choose the destination drive only if you 
install the component on the selected machine 
for the first time. If there have been any 
FactoryTalk Historian components installed on 
the machine before, the Installation drive list 
will appear dimmed. 
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10. 
11. In the AF Server Components Configuration screen, define

the following.
12. In the Database server name box, type the name of a

Microsoft SQL Server or an SQL Server named instance
that will host the AF SQL database.

• To use the local default instance created by Microsoft
SQL Server Express, leave the default database name
displayed in the text box.

• To use another SQL Server database instance, type
the name of the computer on which the database is
located, followed by the name of the instance that
hosts the AF SQL database, if the instance name is
different than the default one. For example:
SQLDBSERVER\SQLDBINSTANCE.

13. From the Installation mode list, select one of the
following installation modes:

IMPORTANT Please choose your installation modes
with caution. You will not be able to 
change them for this computer in the 
future. 
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14. 

Choose this mode: To: 

(1) AF Application
Service and AF SQL
Database

Install both the service and the 
scripts for creating the AF SQL 
database. 
The scripts will be executed 
during the installation process, 
which will result in creating the 
AF SQL database in the selected 
instance of the SQL server. 

(2) AF Application
Service and AF SQL
Database with
unprocessed
database scripts

Install both the service and the 
scripts for creating the AF SQL 
database. 
You will need to process the 
scripts yourself to create the AF 
SQL database. 

(3) AF Application
Service

Install the service only. 
For this installation mode it is 
recommended that you already 
have a separate computer with 
the SQL server instance and the 
AF SQL database created. 

(4) AF SQL Database Install the scripts for creating the 
AF SQL database. 
The scripts will be executed 
during the installation process, 
which will result in creating the 
AF SQL database in the selected 
instance of the SQL server. 

(5) AF SQL Database
with unprocessed
database scripts

Install the scripts for creating the 
AF SQL database. 
You will need to process the 
scripts yourself to create the AF 
SQL database. 
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Choose this mode: To: 

NOTES • For more information on the
installation modes, see "Installation 
modes for FactoryTalk Historian Asset 
Framework (page 36)". 

• For more information on using the
database scripts to manually create the
database, see "Manually create or
upgrade the AF SQL database (page
71)".

15. Click Next.

• If you have selected to install both the AF service
and the AF SQL database (installation mode 1) or
the database only (installation mode 4), the
installation wizard will test the connection with the
database instance. If the connection test fails, an error
message generated by the database server appears,
for example:

Click OK. Follow the instructions provided in the 
message to verify the connection and then click Next 
on the wizard page to resume the installation. 

• If you have selected either to install the AF SQL
database only (installation mode 4) or the AF SQL
database with the unprocessed database scripts
(installation mode 5), the following message will
appear:
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See "Manually create or upgrade the AF SQL 
database (page 71)" for more information. 

16. In the Installation Progress screen, click Install. A
progress bar displays your installation progress.

17. If the release notes display, close the release notes and
continue with the installation.

18. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 

The FactoryTalk Historian SE Server suite is installed with the 
following FactoryTalk Historian components: 

• PI Data Archive

• PI AF Client

• PI GenericNames DLL

• PI Interface Configuration Utility

• FactoryTalk Historian SE RA Components

• FactoryTalk Historian SE WCF Installer

Install the FactoryTalk 
Historian SE server 
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• FactoryTalk Historian SE Core

• FactoryTalk Historian SE x64 Core

• FactoryTalk Historian Live Data Interface Core

NOTE The FactoryTalk Historian SE server must be
installed on one of the following operating 
systems: 
• Microsoft Windows Server 2019
• Microsoft Windows Server 2016
• Microsoft Windows Server 2012 Standard R2

64-bit
If you try to install it on any other operating 
system, the following message will appear and the 
installation will be aborted. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

To install the FactoryTalk Historian SE server: 

NOTE During the installation, the PI Buffering
Administrators user group is created. 

1. Run the FactoryTalk Historian SE installation wizard.
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2. On the welcome page of the installation wizard, click
Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Server.

3. If you do not have the required version of Microsoft .NET
Framework installed on your system, you will be asked to
install it. See steps 3-5 of “Install the FactoryTalk
Historian Asset Framework server” (page 33).

4. In the welcome screen of the Historian SE Server Suite
installation wizard, click Next.

5. In the License agreement screen, accept the license
agreement and click Next.

6. On the Customer Information page, enter your user
name, organization, and the 10-digit product serial
number, e.g. 0123456789.

7. In the Review Component Installation screen, verify that
the components you want installed are listed and click
Next.

8. In the Destination Drive screen, select the drive where you
want the Historian SE Server Suite to be installed and
click Next.
If there is not enough free space available on the drive, a
warning message will appear below the Installation drive
list. In such a case, select another drive or increase the
available space on the drive you have originally selected.
For more information on disk space requirements, see the
FactoryTalk Historian SE Release Notes.

TIP You can choose the destination drive only if you 
install the component on the selected machine 
for the first time. If there have been any 
FactoryTalk Historian components installed on 
the machine before, the Installation drive list 
will appear dimmed. 

9. In the Installation Progress screen, click Install.
10. A message displays indicating that certain components of

this installation will required you to reboot the machine
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after the installation completes. Click Yes to start the 
installation or No to abort it. 

A progress bar displays your installation progress. 
11. If the release notes display, close the release notes and

continue with the installation.

12. 
This step is optional. 
You can perform it after you install the suite. 
For details on locating the FactoryTalk Directory server 
computer, see "Locate the FactoryTalk Directory server 
computer (page 31)". 

13. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 

14. In the Confirm the reboot dialog, click Yes to reboot your
machine.

The FactoryTalk Historian Live Data Interface collects data 
points (tags) from the data server and passes them to the 
FactoryTalk Historian SE server. 

Install the FactoryTalk Historian Live Data Interface component 
on the same computer as the data server and separate from the 
computer that has the FactoryTalk Historian SE server installed. 

Install the FactoryTalk 
Historian Live Data 
Interface (optional) 
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After installing the interface, configure the buffering service on 
the Historian interface computer. The buffering service stores 
data in its memory so that in the event the interface is not able 
to communicate with the FactoryTalk Historian SE server, the 
data will not be lost. 

By default, the FactoryTalk Historian Live Data Interface is 
installed during the installation of the FactoryTalk Historian SE 
Server. Such a configuration is typically used for demonstration 
purposes rather than real-life production environments. It is 
recommended to install the FactoryTalk Historian Live Data 
Interface on a data server computer. 

The FactoryTalk Historian Live Data Interface is installed with 
the following FactoryTalk Historian components: 

• PI System Management Tools

• PI AF Client

• PI GenericNames DLL

• PI Interface Configuration Utility

• PI Interface for OPC DA (OPCInt)

• FactoryTalk Historian SE RA Components

• FactoryTalk Historian Live Data Interface Core

NOTE For more information on buffering, see "Enable
Buffering (page 132)". 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

To install the FactoryTalk Historian Live Data Interface on 
the data server computer: 

NOTE During the installation, the PI Buffering
Administrators user group is created. 
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1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Live Data Interface.

3. If you do not have the required version of Microsoft .NET
Framework installed on your system, you will be asked to
install it. See steps 3-5 of “Install the FactoryTalk
Historian Asset Framework server” (page 33).

4. In the welcome screen of the Live Data Interface Suite
installation wizard, click Next.

5. In the License agreement screen, accept the license
agreement and click Next.

6. In the Review Component Installation screen, verify that
the components you want installed are listed and click
Next.

7. In the Destination Drive screen, select the drive where you
want the Live Data Interface Suite to be installed and click
Next.
If there is not enough free space available on the drive, a
warning message will appear below the Installation drive
list. In such a case, select another drive or increase the
available space on the drive you have originally selected.
For more information on disk space requirements, see the
FactoryTalk Historian SE Release Notes.

TIP You can choose the destination drive only if you 
install the component on the selected machine 
for the first time. If there have been any 
FactoryTalk Historian components installed on 
the machine before, the Installation drive list 
will appear dimmed. 

8. In the Installation Progress screen, click Install.
A message displays indicating that certain components of
this installation will required you to reboot the machine after
the installation completes. Click Yes to start the installation
or No to abort it.
A progress bar displays your installation progress.
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9. If the release notes display, close the release notes and
continue with the installation.

10. Close the Release Notes and continue with the installation.

11. 
This step is optional. 
You can perform it after you install the suite. 
For details on locating the FactoryTalk Directory server 
computer, see "Locate the FactoryTalk Directory server 
computer (page 31)". 

12. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 

13. In the Confirm the reboot dialog, click Yes to reboot your
machine.

The FactoryTalk Historian SE Management Tools are installed 
automatically as a part of the FactoryTalk Historian SE 
installation. This option allows you to install just the 
Management Tools on a non-FactoryTalk Historian Server 
computer, typically a FactoryTalk View SE client computer or a 
remote computer, from which you can perform administrative 
tasks. 

The FactoryTalk Historian SE Management Tools are installed 
with the following FactoryTalk Historian components: 

Install the FactoryTalk 
Historian SE 
Management Tools 
(optional) 
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• PI System Management Tools

• PI AF Client
This component also includes the Analysis Management
plug-in to PI System Explorer that lets you manage bulk
operation on analyses, edit the service configuration, and
view service statistics.

• PI GenericNames DLL

• PI Interface Configuration Utility

• FactoryTalk Historian SE RA Components

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

To install the FactoryTalk Historian SE Management Tools: 

NOTE During the installation, the PI Buffering
Administrators user group is created. 

TIP The screenshots presented in the following 
instruction illustrate typical installation or upgrade 
steps. Individual steps may differ though, depending 
on the actual system configuration. 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Management Tools.

3. If you do not have the required version of Microsoft .NET
Framework installed on your system, you will be asked to
install it. See steps 3-5 of “Install the FactoryTalk
Historian Asset Framework server” (page 33).

4. In the welcome screen of the Management Tools Suite
installation wizard, click Next.

5. In the License agreement screen, accept the license
agreement and click Next.
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6. In the Review Component Installation screen, verify that
the components you want installed are listed and click
Next.

7. In the Destination Drive screen, select the drive where you
want the Management Tools Suite to be installed and click
Next.
If there is not enough free space available on the drive, a
warning message will appear below the Installation drive
list. In such a case, select another drive or increase the
available space on the drive you have originally selected.
For more information on disk space requirements, see the
FactoryTalk Historian SE Release Notes.

TIP You can choose the destination drive only if you 
install the component on the selected machine 
for the first time. If there have been any 
FactoryTalk Historian components installed on 
the machine before, the Installation drive list 
will appear dimmed. 

8. In the Installation Progress screen, click Install.
A message displays indicating that certain components of
this installation will required you to reboot the machine after
the installation completes. Click Yes to start the installation
or No to abort it.
A progress bar displays your installation progress.

9. If the release notes display, close the release notes and
continue with the installation.

10. 
This step is optional. 
You can perform it after you install FactoryTalk Historian 
SE Management Tools. 
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For details on locating the FactoryTalk Directory server 
computer, see "Locate the FactoryTalk Directory server 
computer (page 31)". 

11. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 

12. In the Confirm the reboot dialog, click Yes to reboot your
machine.

FactoryTalk Historian Analysis Service is a feature in 
FactoryTalk Historian Asset Framework that lets you create and 
manage analyses. The feature consists of the following 
components: 

• PI Analysis Service, with which you run the analyses.

• PI System Explorer, with which you configure the
analyses. It is installed with PI AF Client.
Apart from FactoryTalk Historian Analysis Service, PI AF
Client is also installed with the following suites:

• FactoryTalk Historian SE

• FactoryTalk Historian Live Data Interface

• FactoryTalk Historian SE Management Tools

• Analysis Management plug-in, with which you can use
advanced features related to analysis management and
bulk operations.
It is an optional plug-in to PI System Explorer.

• Apart from FactoryTalk Historian Analysis Service, the
plug-in is also installed with FactoryTalk Historian SE
Management Tools.

Install the FactoryTalk 
Historian Analysis 
Service 
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The FactoryTalk Historian Analysis Service suite is installed 
with the following FactoryTalk Historian components: 

• PI AF Client

• PI Analysis Service
This component also includes the Analysis Management
plug-in to PI System Explorer that lets you manage bulk
operation on analyses, edit the service configuration, and
view service statistics.

NOTE The FactoryTalk Historian SE server must be
installed on one of the following operating 
systems: 
• Microsoft Windows Server 2019
• Microsoft Windows Server 2016
• Microsoft Windows Server 2012 Standard R2

64-bit
If you try to install it on any other operating 
system, a message will appear and the installation 
will be aborted. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

Before you begin, take into account the following: 

• Install and configure the FactoryTalk Historian Asset
Framework server first.
If the FactoryTalk Historian Analysis Service is installed
on a different computer than the FactoryTalk Historian
Asset Framework server, you will need to change the
FactoryTalk Historian Analysis Service logon account
settings to allow FactoryTalk Historian Analysis Service
to fetch analysis data from the FactoryTalk Historian Asset
Framework server.
For details, see "Change logon account settings for
FactoryTalk Historian Analysis Service" (page 78).
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• During the installation, FactoryTalk Historian Analysis
Service will open the port 5463. It is required to configure
FactoryTalk Historian Analysis Service via PI System
Explorer.
If you encounter any issues with the connection, you can
manually open the port. For details, see "Manually
configure Windows Firewall for FactoryTalk Historian"
(page 95) for more details.
See "PI Analysis Service Installation Guide" for details
how to configure FactoryTalk Historian Analysis Service
in PI System Explorer.

NOTE If the installer cannot connect to the specified
FactoryTalk Historian Asset Framework server the 
installation will not continue. 

• There can be only one instance of FactoryTalk Historian
Analysis Service associated with a given FactoryTalk
Historian Asset Framework server.

IMPORTANT During the installation, you will associate the
instance of FactoryTalk Historian Analysis Service 
with a FactoryTalk Historian Asset Framework 
server. If you point to a FactoryTalk Historian 
Asset Framework server that has been associated 
with another FactoryTalk Historian Analysis 
Service instance so far, this association will be 
broken without warning and replaced with the 
new one. 

To install the FactoryTalk Historian Analysis Service: 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Analysis Service.

3. If you do not have the required version of Microsoft .NET
Framework installed on your system, you will be asked to
install it. See steps 3-5 of “Install the FactoryTalk
Historian Asset Framework server” (page 33).
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4. In the welcome screen of the Analysis Service Suite
installation wizard, click Next.

5. In the License agreement screen, accept the license
agreement and click Next.

6. In the AF Server Connection Configuration screen, enter
the server name of your AF server and click Next.

7. In the Review Component Installation screen, verify that
the components you want installed are listed and click
Next.

8. In the Destination Drive screen, select the drive where you
want the Analysis Service Suite to be installed and click
Next.
If there is not enough free space available on the drive, a
warning message will appear below the Installation drive
list. In such a case, select another drive or increase the
available space on the drive you have originally selected.
For more information on disk space requirements, see the
FactoryTalk Historian SE Release Notes.

TIP You can choose the destination drive only if you 
install the component on the selected machine 
for the first time. If there have been any 
FactoryTalk Historian components installed on 
the machine before, the Installation drive list 
will appear dimmed. 

9. In the Installation Progress screen, click Install.
A progress bar displays your installation progress.

10. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 
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The FactoryTalk Historian SE media provides an option to 
install a service that allows you to use notification rules to 
generate alerts. 

To install the FactoryTalk Historian Notifications Service: 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Notifications Service.

3. If you do not have the required version of Microsoft .NET
Framework installed on your system, you will be asked to
install it. See steps 3-5 of “Install the FactoryTalk
Historian Asset Framework server” (page 33).

4. In the welcome screen of the Notifications Service Suite
installation wizard, click Next.

5. In the License agreement screen, accept the license
agreement and click Next.

6. In the AF Server Connection Configuration screen, enter
the server name of your Notification service and click
Next.

7. In the Review Component Installation screen, verify that
the components you want installed are listed and click
Next.

8. In the Destination Drive screen, select the drive where you
want the Analysis Service Suite to be installed and click
Next.
If there is not enough free space available on the drive, a
warning message will appear below the Installation drive
list. In such a case, select another drive or increase the
available space on the drive you have originally selected.
For more information on disk space requirements, see the
FactoryTalk Historian SE Release Notes.

Install Notifications 
Service 
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TIP You can choose the destination drive only if you 
install the component on the selected machine 
for the first time. If there have been any 
FactoryTalk Historian components installed on 
the machine before, the Installation drive list 
will appear dimmed. 

9. In the Installation Progress screen, click Install.
A progress bar displays your installation progress.

10. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TREND The installation log, fth_installer.log, is
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 

The FactoryTalk Historian SE media contain several optional 
Historian components used for data management, such as 
FactoryTalk Historian DataLink (requires the DataLink 
activation) or PerfMon Health Monitor. These components are 
located in the Redist folder on the installation media. 

If you choose to install these components, be sure to install 
them after you install FactoryTalk Historian SE. For further 
information regarding these components, refer to the 
FactoryTalk Historian SE documentation, available in the 
Redist\Docs folder on the FactoryTalk Historian SE installation 
media. 

Microsoft .NET Framework 4.8 is a prerequisite for installing 
the FactoryTalk Historian SE 7.0 suites. It is installed 
automatically during the installation of FactoryTalk Services 
provided on the installation media. 

Install additional 
Historian components 

About installing 
Microsoft® .NET 
Framework 
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If the FactoryTalk Services version on the computer is not the 
same with the one in FactoryTalk Historian SE 7.0 suites 
installation package, you need to install .NET Framework 4.8 
separately. 

A prerequisite for installing .NET Framework 4.8 on Microsoft 
Windows Server 2012 R2 and Microsoft Windows 8.1 is that 
you have Microsoft April 2014 update rollup installed first. For 
details, see the Windows RT 8.1, Windows 8.1, and Windows 
Server 2012 R2 update: April 2014. 

Once you have the necessary Microsoft updates installed, .NET 
Framework 4.8 can be installed. It will require that you restart 
your computer before you can complete the installation. 

Important information for the upgrade process: 

The requirement of restarting your computer during the .NET 
Framework installation has a significant impact on the upgrade 
process. Because you need to stop certain services before 
upgrading a FactoryTalk Historian SE suite, you need to stop 
them again once the .NET Framework 4.8 installation is 
complete and the computer is restarted. 

Advanced Server is a collection of add-on components to 
FactoryTalk Historian SE Server. The Advanced Server 
includes: 

• ACE Advanced Computation Engine for Visual Basic
calculations on Historian data

• Data Access

• JDBC Data Provider

• ODBC

• OLE DB Enterprise

• OLE DB Provider

• OPC DA and HDA Servers

Advanced Server 
components (optional) 

https://support.microsoft.com/en-us/help/2919355/windows-rt-8-1-windows-8-1-and-windows-server-2012-r2-update-april-201
https://support.microsoft.com/en-us/help/2919355/windows-rt-8-1-windows-8-1-and-windows-server-2012-r2-update-april-201
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• SQL Data Access Server

To install the Advanced Server components: 

Select the component that you want to install and click the link 
to learn more. 

• ACE (page 63)

• JDBC (page 64)

• ODBC (page 64)

• OLEDB Enterprise (page 64)

• OLEDB Provider (page 65)

• OPC DA/HDA Server (page 66)

• SQL Data Access Server (page 67)

To activate the Advanced Server components: 

• See "Activating the FactoryTalk Historian SE server (page
81)" to learn about the activation process.

• See "Types of licenses (page 101)" to learn about the
license activation.

To configure the Advanced Server components, see 
"Configuring the Advanced Server components (page 177)" 
for details. 

New users may activate the Advanced Server components with 
the following license activations: 

This license Activates 

FHSE.Advanced 
FHSE.Enterprise 

All the components of the Advanced Server. 

Types of licenses 
activating the 
Advanced Server 
components 
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This license Activates 
FHSE.OLEDB • ODBC

• OLE DB Enterprise
• OLE DB Provider
• SQL Data Access Server

FHSE.OPC • OPC DA Server
• OPC HDA Server
• OPC HDA DA Server

For users upgrading their license activations from FactoryTalk 
Historian SE 2.2/2.1, the Advanced Server components are 
activated automatically when the total license count of the 
FHLD and PTY3 license activations is at least 250. 

You can install the Advanced Server components on computers 
with the following prerequisites met: 

Prerequisites for 
installing the Advanced 
Server components 
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Computer Description 

FactoryTalk 
Historian SE 
server 
computer 

Operating system: 
• Microsoft Windows Server 2019
• Microsoft Windows Server 2016
• Microsoft Windows Server 2012 Standard R2

(64-bit)
• Microsoft Windows Server 2012 Standard (64-

bit)
• Microsoft Windows Server 2008 R2 with

Service Pack 1 (64-bit)
• Microsoft Windows Server 2008 R2 (64-bit)

Software installed and configured: 
• Microsoft .NET Framework 4.8 or newer

versions
• FactoryTalk Services (page 28)
• Microsoft SQL Server Express (page 27)

FactoryTalk Historian suites installed and 
configured: 
• FactoryTalk Historian SE server (page 44)
• FactoryTalk Historian Asset Framework server

(page 33)
• The MDB to AF synchronization performed

(page 77) and verified (page 77).
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Computer Description 
Standalone 
computer 

Operating system: 
• Microsoft Windows Server 2019
• Microsoft Windows Server 2016
• Microsoft Windows Server 2012 Standard R2

(64-bit)
• Microsoft Windows Server 2012 Standard (64-

bit)
• Microsoft Windows Server 2008 R2 with

Service Pack 1 (64-bit)
• Microsoft Windows Server 2008 R2 (64-bit)
• Microsoft Windows 10 (64-bit)
• Microsoft Windows 8.1 (64-bit)
• Microsoft Windows 7 Professional with Service

Pack 1 (32-bit and 64-bit)
Software installed and configured: 
• Microsoft .NET Framework 4.8 or newer

versions
• FactoryTalk Services

NOTE For more information on compatible versions of the
products listed above, refer to the Release Notes. 

To install ACE: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIACESetup\.

2. Double-click Setup.exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

After the installation is complete, the Advanced Server 
component is available from the PI System item in the Start 
menu. 

Install ACE 
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NOTE To use PI JDBC Driver, install SQL Data Access Server
(page 67) first. 

To install PI JDBC Driver: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\
JDBC\.

2. Double-click Setup.exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

NOTE To use ODBC, install SQL Data Access Server (page
67) first.

To install ODBC: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\
ODBC\.

2. Double-click Setup.exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

TIP If you want to have access only to FactoryTalk 
Historian Time series data, install PI OLEDB Provider 
(page 65) instead of OLE DB Enterprise. 

PI OLEDB Enterprise is an OLE DB data provider which 
provides access to the PI System in a relational view, accessible 
through SQL queries. This provider supports read-only access to 
asset and event data stored in the PI Asset Framework (AF), 
such as AF Elements, AF Attributes and PI Event Frames. PI 
OLEDB Enterprise also provides read-only access to time series 

Install JDBC 

Install ODBC 

Install OLEDB 
Enterprise 
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data from the PI Data Archive, since Attributes can be 
configured to reference PI points. 

To install PI OLEDB Enterprise: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\
OLEDB Enterprise\.

2. Double-click Setup.exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

After the installation is complete, the Advanced Server 
component is available from the PI System item in the Start 
menu. 

TIPS • If you have already installed PI OLEDB Enterprise
(page 64), skip installing PI OLEDB Provider.

• If you install PI OLEDB Provider without PI OLEDB
Enterprise, you will have access only to FactoryTalk
Historian Time series data.

The classic PI OLEDB Provider, based on the Microsoft Object 
Linking and Embedding Database (OLE DB) standard, allows 
relational queries to the PI Server using SQL queries. 

Please note there are no more planned releases for the classic PI 
OLEDB Provider. It is recommended to use PI OLEDB 
Enterprise, which provides access to the PI System data through 
PI Asset Framework (AF). 

To install PI OLEDB Provider: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\
OLEDB Provider\.

2. Double-click Setup.exe.

Install OLEDB Provider 
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The installation wizard appears. 
3. Follow the on-screen instructions to complete the process.

After the installation is complete, the Advanced Server 
component is available from the PI System item in the Start 
menu. 

The location and the name of the installation file differs 
depending on the following: 

• If you want to use only the OPC DA server, use the PI-
OPC-DA-Server-2018-Patch-1-(x64).exe file from the
OPC DA Server folder.

• If you want to use both the OPC DA and HDA servers, use
the Setup.exe file from the OPC HDA Server folder.

To install the OPC DA server: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\OPC
DA Server\.

2. Double-click PI-OPC-DA-Server-2018-Patch-1-
(x64).exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

To install the OPC DA and OPC HDA servers: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\OPC
HDA Server\.

2. Double-click Setup.exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

Install OPC DA and 
OPC HDA Server 
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After the installation is complete, the Advanced Server 
component is available from the PI System item in the Start 
menu. 

To install PI SQL Data Access Server: 

1. On your FactoryTalk Historian SE installation media, go
to Redist\Advanced Server Options\PIDASSetup\PI
SQL DAS\.

2. Double-click Setup.exe.
The installation wizard appears.

3. Follow the on-screen instructions to complete the process.

After the installation is complete, the Advanced Server 
component is available from the PI System item in the Start 
menu. 

Install SQL Data Access 
Server 
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Chapter 4 

Post-installation tasks 

In this chapter you will learn about the following tasks that you 
should perform after installing FactoryTalk Historian SE: 

• View the Historian server installation log file (page 69).

• Verify that Historian services are running (page 69).

• Verify that the Historian server is updating data for default
tags (page 70).

• Opening System Management Tools on Windows Server
(page 71)

• Manually create or upgrade the AF SQL database (page
71).

• Perform the MDB to AF synchronization (page 77).

• Verify the MDB to AF synchronization (page 77).

• Disable virus scanning (page 77).

• Change logon account settings for FactoryTalk Historian
Analysis Service (page 78).

You can open the installation log, fth_installer.log, directly 
from the installation wizard. If you want to refer to it later, open 
it from the following location: 
C:\Program Files\Rockwell Software\FactoryTalk 
Historian\Installation Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of the 
Installation>. 

Use Historian Services in System Management Tools to view, 
configure, start and stop Historian services for each connected 
Historian server. The status of each service is updated every 30 
seconds by default. You may change this refresh rate. You can 

View the installation 
log file 

Verify that Historian 
services are running 
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also view the status, errors, and thread details for services used 
by the connected Historian server, and export a list of Historian 
services. 

To open Historian services: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the server for
which you want to view the information.

3. Under System Management Tools, select Operation >
PI Services.

4. Verify that the following Historian services and default
interfaces are running:

• Archive Subsystem

• Backup Subsystem

• Base Subsystem

• License Manager

• Network Manager

• Snapshot Subsystem

• SQL Subsystem

• Update Manager

Depending on your license, you might see additional services. 

To verify that the Historian server is updating data for 
default tags: 

1. Install PI Interface for Random. (The installation kit 
is located at Redist\Interfaces\Random)

2. Create default tags.

Verify that the 
Historian server is 
updating data for 
default tags 
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For detailed steps, refer Redist\Docs\Interfaces\PI-
Interface-for-Random-Simulator-Data-3.5.1-User-
Guide.pdf 

3. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

4. Under Collectives and Servers, select the Historian server
whose data you want to view.

5. Under System Management Tools, select Data >
Archive Editor.

6. In the (Tag Not Specified) tab, click .
The Tag Search dialog box appears.

7. In the Tag Mask text box, type cdt158, and click Search.
The cdt158 tag appears in the search results list.

8. Click OK.
The list of events of the selected tag is displayed in the tab
in the right pane of the System Management Tools dialog
box.

NOTE For more information on the Archive Editor,
click . 

To open System Management Tools using your Start menu, 
enter System Management Tools and select the System 
Management Tools result. 

You can choose to manually install or upgrade the AF SQL 
database (PIFD) by selecting either of the installation modes 
during the installation or the upgrade of the AF server: 

• AF Application Service and AF SQL Database with
unprocessed database scripts.

• AF SQL Database with unprocessed database scripts.

Opening System 
Management Tools on 
Windows Server 

Manually create or 
upgrade the AF SQL 
database 
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The SQL Server scripts and the GO.bat file are placed in the 
..\PIPC\AF\SQL folder. The GO.bat file contains the commands 
that execute the deployed SQL Server scripts manually. 

Upon execution, the scripts create the AF SQL database (PIFD) 
and populate its tables. 

The execution of the scripts must occur from an account with 
sysadmin privileges on the SQL Server instance. 

In this chapter you will learn how to: 

• Create the AFServers local group on the AF application
service computer (page 72).

• Execute the SQL scripts to create and populate the AF
SQL database (page 73).

• Modify the AF application service connect string (page
74).

• Configure the AF application service to point to a different
AF SQL database (page 76).

Before you run the SQL scripts, follow these steps to enable 
interaction between the AF application service and the AF 
SQL database: 

1. On the computer where you installed the AF SQL
database, open Computer Management.

2. Create the AFServers local group, if it does not already
exist.

3. Do either of the following:

• If the AF application service is not running under a
domain account, add the AF application service
computer name to the AFServers group, using this
syntax:

DOMAIN\ComputerName 

Create the AFServers 
local group on the AF 
application service 
computer 
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In this example, the domain is RA and the computer 
name is RADAT. 

• If the AF application service is running under a domain
account, add the name of the domain account under
which the AF application service is running to the
AFServers group. Be sure to include domain
information for the system using this format:

DOMAIN\DomainAccount 

4. Create a SQL Server login and map it to the AFServers
local user group.

To manually create or upgrade the AF SQL database after 
installing the SQL scripts, run the SQL scripts from the SQL 
folder. Here is some example syntax: 

• SQL Server authentication example
The following command is an example of using SQL
Server authentication on a SQL Server that includes an
instance name:

Execute the SQL scripts 
to create and populate 
the AF SQL database 
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GO.bat MySQL\MyInstance PIFD MySQLLogin MySQLLoginPwd 

• Windows authentication example
The following command is an example of using Windows
Authentication on a SQL Server that does not include an
instance name:

GO.bat MySQL PIFD 

To execute the SQL scripts: 

1. If this is an upgrade, stop the AF server services.
2. Open a command prompt window.

Use osql to run these commands if the T-SQL command-
line utility, sqlcmd, is not installed on your system.

3. Use the following syntax to execute the SQL scripts found
in the SQL folder:

GO.bat <SQLName>[\<SQLInstanceName>] PIFD [<SQLUserName> 
<SQLUserPassword>] 

where: 

• <SQLName>

is the name of the SQL Server into which the AF
SQL database (PIFD) will be installed.

• \<SQLInstanceName>

is optional, and should be included if the SQL Server
was installed with an instance name.

• PIFD

is the name of the AF SQL database.

• <SQLUserName> and <SQLUserPassword>
are optional, and should be used if SQL Server
authentication is required to connect to the SQL
Server. If not provided, the scripts use Windows
authentication to connect to the SQL Server.

The process is complete when the command line looks 
like: 

c:\..\PIPC\AF\SQL\PISYSOLEDB>_ 
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Modify the AF application service connect string to enable 
communication between the AF server and the AF SQL 
database. 

On each AF application service computer, follow these 
steps: 

1. In Windows Explorer, navigate to the ..\PIPC\AF folder.
2. Use a text editor to open the AF application service

configuration file, AFService.exe.config.
3. Enter the name of the remote SQL Server, and the named

instance if applicable, in the connect string server.
Refer to the following lines of code:

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

 <appSettings> 

 <add key="connectString" value="Persist 
Security Info=False;Integrated 
Security=SSPI;server=<SQLName>[\SQLInstance];database=PIFD;App
lication Name=AF Application Server;"/> 

 <add key="streamedPort" value="5459"/> 

If the SQL Server is running on a cluster, it is important to 
use the clustered resource IP address, instead of a 
computer name. 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

 <appSettings> 

 <add key="connectString" value="Persist 
Security Info=False;Integrated 
Security=SSPI;server=<SQLClusterName>[\SQLInstance];database=P
IFD;Application Name=AF Application Server;"/> 

 <add key="streamedPort" value="5459"/> 

If the SQL Server is configured to use SQL Server 
mirroring, then add Failover
Partner=<SQLServerName>[\<InstanceName>] after the server=, 
as shown in the following lines of code: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

 <appSettings> 

 <add key="connectString" value="Persist 
Security Info=False;Integrated 
Security=SSPI;server=<SQLName>[\SQLInstance];failover 

Modify the AF 
application service 
connect string 
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partner=<SQLName>[\SQLInstance];database=PIFD;Application 
Name=AF Application Server;"/> 

 <add key="streamedPort" value="5459"/> 

To enable encrypted communication, add encrypt=Yes; to 
the code. See the Microsoft SQL Native Client 
documentation for other options. 

4. If the AF application service is running, stop and restart it
for your changes to take effect.

If you need to direct your AF application service to a different 
AF SQL database, perform the following instructions to specify 
a new SQL Server instance and to enable communications. 

To specify a new SQL Server instance and enable 
communications: 

1. On the AF application service computer, edit the
AFService.exe.config file in the PIPC\AF folder and replace
the server information with the name of the remote SQL
Server to be accessed.

2. Restart the AF application service computer.
3. If the AF application service is using the NetworkService

or LocalSystem account, add the Domain\Machine Name
for the remote AF server to the local AFServers Windows
group (on the AF SQL database computer.)

4. If the AF application service has been modified to use any
other account, add the account under which it is running to
the local AFServers Windows group (on the AF SQL
database computer.)
For details, see "Create the AFServers local group on the
AF application service computer (page 72)", step 3.

5. Restart the AF SQL database computer.

Configure the AF 
application service to 
point to a different AF 
SQL database 
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Once you have the FactoryTalk Historian Asset Framework and 
the FactoryTalk Historian SE Server installed, you need to set 
up synchronization between the AF service and the Historian 
server. This process is called the MDB to AF transition. For 
more information, refer to the PI-MDB-to-PI-AF-Transition-
Guide_EN.pdf. 

To verify the MDB to AF synchronization: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under System Management Tools, select Operation >
AF Link.

3. Select the Historian server for which you want to verify
the synchronization.

• If the synchronization is operating correctly, a green
icon  appears next to the name of the server.

• If the synchronization fails, a red icon appears. Click
in the System Management Tools dialog box for
information on how to diagnose and solve the problem.

Rockwell Automation considers it a good practice to exclude 
the following directories from anti-virus software scanning: 

• On Historian server computers, exclude the Server\arc,
Server\dat, and Server\queue directories and any
directory where archive or event queue files are located.

• For Interface nodes, exclude the pipc\dat and pipc\log
directories, as well as the directory where buffer queue
files are located.

By excluding these directories you avoid random signature 
match incidents, potential performance impacts, and conflicts 
with locked files. 

Perform the MDB to AF 
synchronization 

Verify the MDB to AF 
synchronization 

Disable virus scanning 
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NOTE For more details, see the PI-Data-Archive-2018-SP3-
Reference-Guide_EN.pdf. For information on the 
location of the user documents, see "User 
documentation (page 17)". 

FactoryTalk Historian Analysis Service needs to connect to the 
FactoryTalk Historian SE server in order to fetch analysis data. 

FactoryTalk Historian Analysis Service is installed with the 
default logon account. You need to change it to a logon account 
with PI Data Archive and PI AF server access permissions. 
Otherwise FactoryTalk Historian Analysis Service won't be able 
to connect to the FactoryTalk Historian SE server. 

NOTE Follow the PI-Server-2018-SP3-Patch-1-Installation-
and-Upgrade-Guide-EN for details on how to grant 
access permissions to service accounts. 

To change the logon account settings for FactoryTalk 
Historian Analysis Service on Windows Server: 

1. In the Windows Start menu, enter Services to launch the
Services dialog box.

2. Right click PI Analysis Service (1), and then click
Properties (2).

Change logon account 
settings for FactoryTalk 
Historian Analysis 
Service 
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3. 
In the This account box (a), type the name of the account 
with PI Data Archive and PI AF server access permissions 
and its password in the Password dialog box and then click 
OK (b). 
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Chapter 5 

Configuring FactoryTalk 
Historian 

In this chapter you will find the following information on 
configuring FactoryTalk Historian SE and its components: 

• Activating the Historian server (page 81).

• Securing the Historian server (page 82).

• Manually configure Windows Firewall for FactoryTalk
Historian (page 95).

• Configuring the Historian server (page 98).

• Configuring the data server (page 125).

• Configuring Historian interface connections (page 125).

• Configuring FactoryTalk Historian Live Data Interface
(page 126).

• Enabling Excel add-ins for FactoryTalk Historian
DataLink (page 143).

• Activating Excel COM add-ins for FactoryTalk Historian
DataLink (page 144)

• Recording messages using FactoryTalk Diagnostics (page
145).

You need to activate the FactoryTalk Historian SE server so that 
it starts collecting data points (tags) from data servers. 

You activate the server by obtaining license activation file(s) 
from the Rockwell Automation licensing website and assigning 
them to the server using the FactoryTalk Activation Manager. 

To activate the FactoryTalk Historian SE server: 

Activating the 
Historian server 
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1. Search for and open FactoryTalk Activation Manager
2. Follow the instructions displayed in the window to

configure your activations.

NOTE Click Help for more information, or refer to the
instructions from the Activate Rockwell Software 
Products leaflet, available with your product 
installation package. 

FactoryTalk Historian SE allows you to manage the Historian 
server authentication through Windows and Microsoft Active 
Directory (AD). This solution improves the Historian server 
security, reduces your management workload, and provides 
users with a single sign-on experience. 

With Windows authentication for the FactoryTalk Historian SE 
Server, users log on to their Windows accounts and are 
automatically authenticated on the Historian server. The 
Historian server comes with a set of preconfigured security 
components created to reflect particular roles that may be 
adopted by users to access the Historian server resources. Each 
user comes with predefined trusts and is assigned to one or more 
groups, depending on the scope of privileges they should have. 
Each group is defined with a different scope of privileges. The 
users and groups are assigned to individual database tables, 
creating in this way a system of permissions for accessing the 
Historian server database resources. 

The users are the central components that connect the Windows 
authentication functionality with the Historian server security 
model. They determine which Windows users are authenticated 
on the Historian server and what access permissions they have 
there (for example, whether the user is allowed to create a point 
or run a backup). 

The connection between the Windows users and/or groups and 
the Historian server security users is established through 
mappings. If you want to grant a Windows user or group access 
to a Historian server resource (such as a point or a module), you 

Securing the Historian 
server 
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need to create on the Historian server mappings between the 
Windows users and/or groups and relevant Historian server 
users or groups. In this way, the Windows users and/or groups 
adopt the permissions from the Historian users to which they are 
mapped. This is the safest, quickest and most convenient way of 
distributing the Historian server privileges. 

You can manage the Historian server security with the System 
Management Tools. 

See the following sections to learn more about the Historian 
server security model: 

• Historian security components and their privileges (page
83)

• Managing Historian security components (page 88)

• Creating security mappings (page 90)

• Managing security of the Historian server database (page
93)

The following components constitute the Historian security 
model: 

Identities Users Groups 

PIEngineers FTHEngineer FTHEngineers 
PIOperators FTHOperator FTHOperators 
PISupervisors FTHSupervisor FTHSupervisors 
PIWorld pidemo FTHAdministrators 

piadmin piusers 

The descriptions and privileges of the security components are 
presented in the following tables: 

Identities 

Historian security 
components and their 
privileges 
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Identities Description and privileges 

PIEngineers A sample identity with engineering duties with no 
pre-configured settings. 

PIOperators A sample identity with operational duties with no 
pre-configured settings. 

PISupervisors A sample identity with supervisory duties with no 
pre-configured settings. 
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Identities Description and privileges 
PIWorld An identity with preconfigured access permissions 

to Historian server resources. It represents the 
"everyone" concept of Windows, and specifies the 
rights of non-explicit users or groups. 
All authenticated Historian server users are given 
at least PIWorld privileges. 
The PIWorld identity has write access to the 
following table: 
• PIMSGSS

The PIWorld identity has read access to the 
following tables: 
• PIAUDIT
• PIBatch
• PIBATCHLEGACY
• PICampaign
• PIDBSEC
• PIDS

• PIHeadingSets
• PIModules
• PIPOINT
• PIReplication
• PITransferRecords
• PIUSER

• The PIWorld identity does not have access to
the following tables:
• PIAFLINK
• PIARCADMIN
• PIARCDATA
• PIBACKUP

• PIMAPPING
• PITRUST
• PITuning

• You can or cannot do the following with the
PIWorld identity:

• You can fully disable it.
• You cannot:
• Delete it.
• Use it in a mapping.
• Use it in a trust.

Users 

Users Description and privileges 

FTHEngineer A preconfigured user, member of the 
FTHEngineers and FTHSupervisors groups. 
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Users Description and privileges 
FTHOperator A preconfigured user, member of the 

FTHOperators group. 
FTHSupervisor A preconfigured user, member of the 

FTHSupervisors group. 
piadmin A preconfigured administrative PI User with 

unrestricted access to Historian server resources. 
You can or cannot do the following with the 
piadmin user: 
• You can disable its properties:
• To be used in a mapping.
• To be used in a trust.
• To be used for an explicit logon.
• You cannot:
• Delete it.
• Fully disable it.

You should map it only to a limited group of 
administrators. 
Piadmin is a member of the FTHEngineers, 
FTHSupervisors, and FTHAdministrators groups. 
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Groups 

Groups Description and privileges 

FTHAdministrators It represents Historian server administrators 
and has read-and-write access to all Historian 
server resources and default points, except 
the following database tables: 
• PIDS
• PIHeadingSets
• PIPOINT

You can or cannot do the following with the 
FTHAdministrators group: 
• You can:
• Map it to the AD group that represents

your Historian server system
administrators.

• Adjust its access permissions to meet your
needs.

• Fully disable it.
• You cannot delete it.

FTHEngineers A preconfigured group with the following 
privileges: 
• Create, modify, and delete point

definitions.
• Read and write access to the following

database tables:
• PIDS
• PIHeadingSets
• PIPOINT

FTHOperators A preconfigured group with the following 
privileges: 
• Read any point definition.
• Read any point’s historical data set.
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Groups Description and privileges 
FTHSupervisors A preconfigured group with the following 

privileges: 
• Read any point definition.
• Read any point’s historical data set.

When the users belonging to the 
FTHSupervisors group create points in the 
FactoryTalk Administration Console, they get 
the following privileges to these points: 
• Add new point data to any point’s historical

data set.
• Add, modify, and delete point data.

piusers A generic PI Group formerly named "piuser". 
This group has no preconfigured access 
permissions. 
You can or cannot do the following with the 
piusers group: 
• You can fully disable it.
• You cannot delete it.

Use the System Management Tools to manage the security 
components and security of your Historian server database. 

NOTE To manage security identities, users, and groups, you
need administrative rights to the Historian server. 

To manage the Historian server security components: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, click the check box next
to the server for which you want to view and manage the
security information.

3. Under System Management Tools, expand Security and
select Identities, Users, & Groups.

Managing Historian 
security components 
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In the right pane, the PI Identities, PI Users, and PI 
Groups tabs appear. 
Each tab contains a set of columns with security-related 
information. To modify the type of information displayed, 
right-click a column name and add or remove columns 
from the context menu. 

4. Click the tab containing the security component type you
want to view and manage.

5. In the selected tab, right-click the security component that
you want to view or modify, and select Properties.
The Properties dialog box appears.
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The content of the dialog box differs depending on the 
security component type you select. 

6. View the settings of the selected security component
presented in the tabs.
You can modify the privileges of the security component
to the extent that is allowed by the component’s
configuration. See "Historian security components and
their privileges (page 83)" for more information.

7. Click OK.

In the FactoryTalk Historian SE security model, if you want to 
give a Windows user privileges from several Historian groups, 
create mappings using the System Management Tools following 
either of the methods: 

• Create a mapping between an Active Directory (AD)
group and a Historian user. In this way, the Windows user
from the AD group used in the mapping gets privileges

Creating security 
mappings 
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from all the Historian groups to which the Historian user 
referred to in the mapping belongs. 

• Create 1-to-1 mappings between each AD group and a
corresponding Historian group. If the Windows user is a
member of only one AD group for which you have created
the mapping, they will get privileges only from the
Historian group referred to in the mapping. If you want the
Windows user to get privileges from several Historian
groups, make sure the user is a member of all the AD
groups that are mapped to the Historian groups whose
privileges the user should get.

Security mappings are required to establish connections 
between the FactoryTalk Historian SE server and any remote 
computer that should be able to communicate with the server 
(such as the Data Server, the Engineering Workstation, and/or 
Client Computers). 

To create a security mapping between a Windows user 
and/or group and a Historian server user: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the server for
which you want to create the mapping.

3. Under System Management Tools, select Security >
Mappings & Trusts.

4. In the Mappings tab, click .
The Add New Mapping dialog box appears.

5. Click  next to Windows Account.
The Select User, Computer, or Group dialog box
appears.

6. In the text box, type the name of the user, for which you
want to create the mapping.
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7. Click Check Names to verify the user name, and click
OK.

8. Click  next to PI Identity.
The Select PI Identity, PI Group, or PI User dialog box
appears.

9. From the Type list, select PI Users.
10. Select the PI user, to which you want to map the selected

Windows user (e.g. piadmin), and click OK.
11. Click OK to apply the changes. The new mapping is listed

in the Mappings tab.

To check if a Windows user/group is mapped to a Historian 
security user: 

1. In the System Management Tools, go to Connections:

2. Select the FactoryTalk Historian SE server to which you
want to connect.
If the server name is not listed, do the following:
a. On the Server menu, click Add Server. The Add

Server dialog box appears.
b. In the Network Node text box, type the fully qualified

domain name (FQDN) of the server.
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c. Clear the Confirm check box, and click OK. The new
server is added to the server list.

3. Once connected to the server, view its properties.
The properties contain the domain name, the Windows
user/group name, and the name of the Historian security
user, to which the Windows user/group is mapped. They
also list other Historian server security components, whose
privileges are shared by the Windows user/group via the
Historian security user.

NOTE To manage security of the Historian server
database, you need administrative rights to the 
Historian server. 

To view and manage security privileges of the Historian 
server database: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

Managing security of 
the Historian server 
database 
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2. Under Collectives and Servers, select the server for
which you want to manage security.

3. Under System Management Tools, select Security >
Database Security.
In the right pane of the dialog box, a list of individual
database tables is displayed.
The Security column contains a summary of security-
related information: a list of the security components
(identities, users, and/or groups) assigned to the database
table, and their rights displayed in brackets.

To modify the type of information displayed, right-click a 
column name and add or remove columns from the context 
menu. 

4. Right-click the name of the database table for which you
want to manage the security information, and select
Properties.
The Security for… dialog box appears.
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5. Click a security component to check its privileges in the
Permissions for… list.
You can modify the privileges of the component for the
database table to the extent that is allowed by the
component’s configuration. See "Historian security
components and their privileges (page 83)" for more
information.

6. Click OK.

If you use Microsoft Windows Firewall on the computers on 
which you have installed FactoryTalk Historian SE, the firewall 
configuration is performed automatically during the installation 
of individual FactoryTalk Historian components, using the 
Rockwell Firewall Configuration Utility (WFCU). 

If you use another utility, you need to configure the firewall 
manually using the following the steps. Refer to the user 
documentation of your firewall configuration utility for more 
information. 

Manually configuring 
Windows Firewall for 
FactoryTalk Historian 
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NOTE You need administrator privileges to perform the
following steps. 

To manually configure the firewall: 

• Open TCP/IP ports in the firewall to accept incoming
connections:
See the following table to learn which ports need to be
open for individual FactoryTalk Historian suites.

For this 
FactoryTalk 
Historian suite: 

Open these ports: Of this type: 

Historian to Historian 
Interface 

5450 TCP 

Asset Framework 5457 
5459 

TCP 
TCP 

Analysis Service 5463 TCP 

Historian Server 5450 
5454 
5455 
5456 
5458 
6000 

TCP 
TCP 
TCP 
TCP 
TCP 
TCP 

Live Data Interface 6000 TCP 

• For the FactoryTalk Historian SE Server and the
FactoryTalk Historian Asset Framework suites, allow
incoming ICMP Echo Request messages.

• Allow FactoryTalk Historian Live Data Interface to
communicate through the firewall:
See the following table to learn which settings you need to
use when configuring the firewall.
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Item Description 

The absolute 
path to the Live 
Data interface 

<PIHOME_Value>Interfaces\LDInterface

\FTLDInt.exe,
where <PIHOME_Value> is the path specified
in the following registry key: 
Computer > HKEY_LOCAL_MACHINE > 
Software > Wow6432Node > PISystem. 
For details, see "Checking the location of 
FactoryTalk Historian Live Data Interface 
(page 97)". 

The name (ID) 
of the Live Data 
interface 

PIUniint Interface to the PI System. 

NOTE For more information on firewall configuration, refer
to the documentation of your firewall. 

To check the location of the Live Data interface: 

1. Open the Windows Registry Editor.
2. Go to Computer > HKEY_LOCAL_MACHINE >

Software > Wow6432Node > PISystem.
3. Double-click the PIHOME value and copy the path from

the value data text box.
The complete path to the Live Data interface will consist
of the following parts:

• The path you get from the registry.

• \Interfaces\LDInterface\FTLDInt.exe
Example: If the PIHOME value points to the following 
location: 
C:\Program Files\Rockwell Software\FactoryTalk 
Historian\PIPC\ 
The complete path to the Live Data interface would be: 
C:\Program Files\Rockwell Software\FactoryTalk 
Historian\PIPC\\Interfaces\LDInterface\FTLDInt.exe 

Checking the location 
of FactoryTalk 
Historian Live Data 
Interface 
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In the following sections you will learn how to configure and 
use the FactoryTalk Historian SE server. 

1. Add the server to the FactoryTalk Directory (page 98)
2. Verify the FactoryTalk Historian Live Data Local

Interface (page 100)
3. Opening FactoryTalk Administration Console on

Windows Server (page 100)
4. Manage licenses (page 100)
5. Configure points (page 117)
6. View current and archive data (page 121)
7. Archive and back up (page 122)
8. Restart the FactoryTalk Historian SE server (page 124)

Once the FactoryTalk Historian SE server is installed and 
running, add it to the FactoryTalk Directory. 

To add the FactoryTalk Historian SE server to the 
FactoryTalk Directory: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, select
Network, and click OK.

3. In the Explorer tree, expand System > Connections.
4. Right-click Historical Data and select New Historian

Server Connection.
5. In the New Historian Server Connection dialog box,

select the name of your FactoryTalk Historian SE server
from the Server or Collective name list, and click Test
Server Connection.

Configuring the 
Historian server 

Adding the server to 
the FactoryTalk 
Directory 
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• If the connection is successful, the Server found
message appears next to the Test Server Connection
button.

• If the connection is not successful, the No server found
message appears next to the Test Server Connection
button. In such a case, check the status of your server in
the Connection Manager.

6. Click Finish. The new server connection with the default
Live Data interface instance FTLD1 appears under the
Historical Data folder.

The local interface is now configured to start collecting data 
points from any data servers that are available to the 
FactoryTalk Historian SE server. 

For more information on the FactoryTalk Historian Live Data 
Interface, see "Configuring FactoryTalk Historian Live Data 
Interface (page 126)". 

If you want to verify if FTLD Interface is properly configured, 
see "Verifying the FactoryTalk Historian Live Data Local 
Interface (page 100)". 

IMPORTANT You can use the local interface for data collection.
However, we strongly recommend that you create 
a remote interface on the computer that has the 
data server installed. Buffering, which ensures 
that the loss of data does not occur, can only be 
enabled on a remote interface. To learn more 
about buffering, see "Enable buffering (page 
132)". 
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To verify that the FactoryTalk Historian Live Data Local 
Interface is configured: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, select
Network, and click OK.

3. In the Explorer tree, expand System > Connections >
Historical Data, and the FactoryTalk Historian SE server
node.

4. Right-click FTLD1, and select Properties.
The Data Collection Interface Properties dialog box
appears.

5. Go to the General tab, and verify in the Service Status
section that the Startup Type is set to Automatic.

6. To start the data collection service, click Start and wait
until the service status changes to Started. For more
information, click the help icon in the dialog box.

7. Click OK to close the dialog box.

To open FactoryTalk Administration Console using your 
Start menu, enter FactoryTalk Administration Console and 
select the FactoryTalk Administration Console result. 

Once you have your activations, you can assign them to your 
Historian server, and allocate tag counts to selected interface 
types (or point sources). 

See the following topics for more information: 

• Types of licenses (page 101)

Verifying the 
FactoryTalk Historian 
Live Data Local 
Interface 

Opening FactoryTalk 
Administration Console 
on Windows Server  

Managing licenses 
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• Learning how licenses are distributed between license
pools (page 105)

• Assigning license activations to the FactoryTalk Historian
SE server (page 108)

• Allocating licenses to interface types (page 111)

• Viewing allocated licenses (page 115)

The license activations you get for your Historian server are 
various types of licenses that you can use in either of the 
following pools of licenses: 

• Rockwell
Groups license activations for Rockwell sources only.

• General
Groups license activations for tags from both Rockwell
and third-party devices.

You may use the following license activations with your 
FactoryTalk Historian: 

Type of 
license 
activation 

Point 
sources 

Description 

FHSE.XXX FTLD* FactoryTalk Live Data connector 
interfaces. 

FTMS Points transferred from a 
FactoryTalk Historian ME 
module. 

FHSE.H2H FTSS FactoryTalk Server to Server 
interfaces. 
The license sets the number of 
points from the FTH2H interface 
to unlimited. 

Types of licenses 
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Type of 
license 
activation 

Point 
sources 

Description 

FHSE.Advanced not applicable Activates the following Advanced 
Server components for the 
standard FactoryTalk Historian 
SE server: 
• ACE Advanced Computation

Engine for Visual Basic
calculations on Historian data

• Data Access
• JDBC Data Provider
• ODBC
• OLE DB Enterprise
• OLE DB Provider
• OPC DA Server
• OPC HDA Server
• OPC HDA DA Server
• PI SQL DAS
• Notifications for using

Microsoft Lync Unified
Communication Server

Note: For users upgrading their 
license activations from 
FactoryTalk Historian SE 2.2/2.1, 
the Advanced Server 
components are activated 
automatically when the total 
license count of the FHLD and 
PTY3 license activations is at 
least 250. 
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Type of 
license 
activation 

Point 
sources 

Description 

FHSE.Enterprise Default point 
sources: 
• FTBOINT
• FTLD
• FTLD1-99
• FTMS
• FTSS
• PIFTBOINT

Third-party 
point sources 

All the default point sources are 
set to unlimited. 
Third party point sources are set 
to the value that has been 
assigned in FactoryTalk 
Administration Console, where 
the maximum allowed value to 
set is 1000000000. 
It means that it is possible to 
create the unlimited number of 
points for the default point 
sources and up to 1000000000 for 
individual third-party point 
source. 
The license also activates all the 
components of the Advanced 
Server. 

FHSE.OLEDB not applicable Activates the following Advanced 
Server components for the 
standard FactoryTalk Historian 
SE server: 
• ODBC
• OLE DB Enterprise
• OLE DB Provider
• SQL Data Access Server

FHSE.OPC not applicable Activates the following Advanced 
Server components for the 
standard FactoryTalk Historian 
SE server: 
• OPC DA Server
• OPC HDA Server
• OPC HDA DA Server
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Type of 
license 
activation 

Point 
sources 

Description 

FTBAInt.XXX FTBOINT 
PIFTBOINT 

FactoryTalk Batch Interface. The 
license sets the number of points 
from the FTBOINT and 
PIFTBOINT interfaces to 
unlimited. 

FHSE3ADD.XXX Third-party 
and Rockwell 
point sources. 

See "How licenses are distributed 
between license pools (page 
105)" for details. 

* The existing default behavior was when a FTLD interface started
up, all points that had FTLD as the point source got sent down to
the interface from the FactoryTalk Historian Server, and then only
the points that matched the interface's unique ID were put on scan.
In very large applications, consisting of hundreds of thousands of
points, or locations where the network bandwidth is limited, this
behavior was not ideal. In version 5.00 or higher, you can edit each
FTLD interface point source and make it a unique number so that
only the data points that match that unique point source number
get sent from the FactoryTalk Historian Server. For details, see the
FactoryTalk Historian Live Data Interface User Guide, section "Use
multiple FTLD point source values".

The names of the license activations have the following 
structure: <Type>.<Quantity>, and contain the following 
information: 

• <Type>
The type of the license activation.

• <Quantity>
The maximum number of individual licenses that can be
allocated to an interface type (or point source). Each
license corresponds to a single point with which the server
can collect data from the interface.
For example, for the FTHSE license activation, the
quantity ranges from 250 to 100K points.
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• For some types of license activations, instead of the
<Quantity> part there is a combination of digits and/or
characters that further describe the activation, e.g.
FTHSE.H2H, FTBAInt.1.

Each license activation contains a number of individual licenses. 
The system distributes the licenses between the Rockwell and 
General license pools, depending on the type of license 
activations you have. When you allocate licenses to interface 
types (or point sources), you take the licenses from either of the 
license pools. 

To use the licenses: 

1. Learn how licenses are distributed between the license
pools. (page 105)

2. Assign the license activations to your Historian server
(page 108).

3. Allocate the individual licenses to interface types (or point
sources) (page 111).

When you acquire license activations for your FactoryTalk 
Historian and assign them to your Historian server, the system 
automatically distributes individual licenses from the license 
activations between the General and Rockwell license pools. 

Learn how licenses are 
distributed between 
license pools 



Chapter 5 Configuring FactoryTalk Historian 

 

106 Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 

The system takes into account the following license activations 
to calculate the volume of the individual license pools: 

• FHSE3ADD

• FHSE

• FHLD

• PTY3

If you want to calculate how licenses from your license 
activations will be distributed between the license pools, 
perform the following steps. 

TIP The symbols used in the formulas presented here 
mean the following: 
∑ "the sum of" 
Min "the lower value of the two in the brackets" 
Max "the greater value of the two in the brackets" 

To calculate the distribution of licenses between the General 
and Rockwell license pools: 

1. Calculate the <BaseLicenseCount> value.
It is an intermediate value that will be used to calculate
your number of licenses of the General pool.

<BaseLicenseCount> = Max (Min(5000, ∑ <FHSE 
licenses>), 20% * ∑ <FHSE licenses>) 

2. Calculate the number of licenses for the Rockwell license
pool.
Take the number of your FHLD licenses, FHSE licenses,
and the <BaseLicenseCount> value, and then substitute
them into the following equation:
<RockwellLicensePool> = ∑ <FHLD licenses> + ∑ <FHSE
licenses> - <BaseLicenseCount> 

3. Calculate the number of licenses for the General license
pool.
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Take the number of your PTY3 licenses, the FHSE3ADD 
licenses, and the <BaseLicenseCount> value, and then 
substitute them into the following equation: 
<GeneralLicensePool> = ∑ <PTY3 licenses> + 
<BaseLicenseCount> + ∑ <FHSE3ADD licenses> 

TIP The symbols used in the formulas presented here 
mean the following: 
∑ "the sum of" 
Min "the lower value of the two in the brackets" 
Max  "the greater value of the two in the brackets" 

In the following example we will calculate how licenses will be 
distributed between the General and Rockwell license pools. 

We will use the following values: 

Activation Value ∑ (sum) 

FHSE.2K 2000 12000 
FHSE.10K 10000 
FHSE3ADD.2K 1 2000 
FHLD.5K 5000 5000 
PTY3.500 500 500 

Total 19500 

Distributing licenses 
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To distribute licenses between the license pools: 

1. Calculate the <BaseLicenseCount> value.
<BaseLicenseCount> = Max (Min(5000, ∑ <FHSE
licenses>), 20% * ∑ <FHSE licenses>)

<BaseLicenseCount> = Max(Min(5000, 12000), 20% *
12000)

<BaseLicenseCount> = Max(Min(5000, 12000), 2400)

<BaseLicenseCount> = Max(5000, 2400)

<BaseLicenseCount> = 5000

2. Calculate the number of licenses for the Rockwell license
pool.
<RockwellLicensePool> = ∑ <FHLD licenses> + ∑ <FHSE
licenses> - <BaseLicenseCount> 
<RockwellLicensePool> = 5000 + 12000 - 5000

<RockwellLicensePool> = 12000

3. Calculate the number of licenses for the General license
pool.
<GeneralLicensePool> = ∑ <PTY3 licenses> +
<BaseLicenseCount> + ∑ <FHSE3ADD licenses>

<GeneralLicensePool> = 500 + 5000 + 2000

<GeneralLicensePool> = 7500

In this example, the total of 19500 licenses has been distributed 
in the following way: 

Licenses and license pools Values 

License total 19500 
Rockwell license pool 12000 
General license pool 7500 

NOTE In order to assign the activations to a FactoryTalk
Historian SE server, the server must be added to 
the FactoryTalk Directory. See "Adding the server 
to the FactoryTalk Directory (page 98)" for more 
information. 

Assigning license 
activations to the 
Historian server 
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To assign the license activations to the server: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, select
Network, and click OK.

3. In the Explorer tree, expand System > Connections >
Historical Data.

4. Right-click the name of the server to which you want to
assign the license activations, and click Properties.

5. In the Historian Server Connection Properties dialog
box, click the Licensing tab. The table displayed in the tab
provides the following information for the selected server:

Item Description 

Activation The type of the license activation. 
Total The total number of license activations of 

the given type. 
In Use The number of license activations of the 

given type that are used by other Historian 
servers. 

Assigned The number of license activations of the 
given type that are assigned to the selected 
server. 

6. To assign a license activation to the server, type a number
in the Assigned column for the selected license activation.
The number shows how many licenses of the selected type
will be assigned to the server.
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After each license activation assignment, the system 
checks the sum of points resulting from the assignments. 
The total sum of points must be equal to or less than 
500 000. If you exceed this limit, the following message 
appears: 

Follow the instructions in the message. 
If you change the number of assigned license activations 
to a lower one, the system performs the following checks: 

• For license activations of type PTY3 and FHSE3ADD
The system checks the sum of limits for third-party
point sources currently set in the Point Sources tab. If
the sum exceeds the allowed limit for point sources
resulting from the number of relevant license
activations that are currently assigned to the Historian
server, an error message appears.

• For all license activations
The system checks the sum of limits for third-party
point sources and the FTMS point source currently set
in the Point Sources tab. If the sum exceeds the
allowed limit for point sources resulting from the
number of relevant license activations that are currently
assigned to the Historian server, an error message
appears.

For either of the two limit checks the following message is 
displayed: 
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NOTE The following license activations are excluded
from the point limit check: AVIEW, FTBAInt, 
FHSE.H2H, FHSE.Advanced, FHSE.OLEDB, and 
FHSE.OPC. 

7. Click Apply.
If you have assigned more license activations than you
currently have available, the following message appears:

Change the number of the license activations, and then 
click Apply again. 

By allocating a license to an interface type (or point source), 
you specify the maximum number of points with which the 
server will collect data from a given interface type (or point 
source). 

Allocating licenses to 
interface types (or 
point sources) 
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To allocate licenses to interface types: 

1. In the Historian Server Connection Properties dialog
box, click the Point Sources tab.

The tab contains two tables that display the following 
information: 

Item name Description 

Interface Type Pools of licenses (Rockwell and General) 
assigned to the server. 
This information cannot be edited. 

Interface Type 
Allocation 

Abbreviated names of interface types (or 
point sources) to which you can allocate 
licenses from the license pools. 
The FTLD interface type is the default type 
and it cannot be edited. 

Points in Use The number of points already configured for 
collecting data from a given interface type. 
This information is updated automatically 
and cannot be edited. 
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Item name Description 
Limit The maximum number of licenses that is 

allocated to a license pool or an interface 
type. 
• For the license pools, the limits are

collected from the license activations.
This information cannot be edited.

• For the FTLD interface type, the limit
equals the total number of unallocated
licenses from both Rockwell and General
license pools. This information is updated
automatically and cannot be edited.

2. In the Interface Type Allocation column, type the
abbreviated name of the interface type (or point source) to
which you want to allocate a license limit. See "Types of
Licenses (page 101)" for more information on the interface
types.

3. In the Limit column, type the maximum number of
licenses for points that the server will use to collect data
from the selected interface type. The number must be a
multiple of 50.
If you type incorrect information in the Interface Type
Allocation or Limit columns, a relevant message will
appear. Read the message to learn about the error, for
example:
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NOTE For PI Notifications, you allocate the maximum
number of licenses for individual notifications 
instead of points. The licenses are taken from 
the Rockwell pool. 

4. Click Apply. The license limit of the FTLD interface type
is updated accordingly:

5. Repeat the steps for other interface types that you want to
add.

6. Click OK.
7. Restart the FactoryTalk Historian SE server (page 124) for

the changes to take effect.

You can view the information on the allocated licenses in 
System Management Tools (page 115). 
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NOTE If you allocate point sources FTLD1-99 and/or
FTMS with the license activation of type 
FHSE.XXX, you will be able to edit the point limit 
for them. Once you change their license activation 
from FHSE.XXX to FHSE.ENTERPRISE, they will 
not be editable anymore and their limit will be set 
to unlimited. See "Types of licenses (page 101)" 
for more information. 

To view the information on the allocated licenses in the 
FactoryTalk Administration Console: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. Log on to the FactoryTalk Directory.
3. In the Explorer tree of the FactoryTalk Administration

Console dialog box, go to System > Connections >
Historical Data.

4. Right-click Production Historian, and select Properties.
The Historian Server Connection Properties dialog box
appears.

5. Click the Point Sources tag.
Under Points in Use, the number of currently used
licenses is displayed.

Viewing allocated 
licenses 
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NOTE For PI Notifications, each notification consumes
1 point in the FactoryTalk Administration 
Console. 

To view the information on the allocated licenses in the 
System Management Tools: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the server for
which you want to view the license information.

3. Under System Management Tools, select Operation >
Licensing.

4. Click Resources >
PointSourcesLimit.<InterfaceTypeName>.

NOTES <InterfaceTypeName> is the abbreviated name
of the interface type you added to the Point 
Sources tab when allocating points. 

The node contains the following information: 

Item name Description 

Description The description of the license limit assigned 
to the interface type (point source). 

Total The total number of licenses allocated to the 
interface type. It corresponds to the Limit 
value in the FactoryTalk Administration 
Console. 
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Item name Description 
Amount Used The number of points already configured for 

collecting data from the interface type. It 
corresponds to the Point in Use value in the 
FactoryTalk Administration Console. 

Amount Left The number of licenses still available for the 
interface type. 

Level The license enforcement level. 
End Time The license expiration date. 

NOTE The numbers provided for PI Notifications in
Total, Amount Used, and Amount Left are 
multiplied by 7 against those set in the 
FactoryTalk Administration Console. It is 
because each notification uses 7 points from the 
Rockwell pool. 
For example, if you set the limit for notifications 
to 50 in the FactoryTalk Administration Console, 
the Total number of allocated licenses in the 
System Management Tools will equal 350. 
Similarly, if you enable 50 notifications, the 
Amount Used value will equal 350. 

Use the FactoryTalk Administration Console to configure your 
FactoryTalk Historian SE server to start collecting data points. 
You can add data points to the server in either of the following 
ways: 

• Adding individual data points manually (page 118).

• Adding multiple data points automatically (page 119).

In order to add individual or multiple data points to your 
Historian server, you need first to define point sources, in which 
you want to search for data points. The point sources may 
include FactoryTalk Linx, RSLinx Classic, other OPC DA 
servers (for example, Kepware OPC), and HMI/ Alarm servers 
(for example, FactoryTalk View). 

Configuring points 
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For more information on adding point sources, refer to the 
FactoryTalk Help, available from the Help > Contents menu in 
the FactoryTalk Administration Console. 

Once you have added the data points to the server, you can 
verify if the points are collected by the server correctly. See 
"Viewing archive data (page 121)" for more information. 

To add individual data points to the FactoryTalk Historian 
SE server: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, choose
the Network directory that you want to use, and click OK.

3. In the Explorer tree, right-click the application from
which you want to collect points, and select Add
Individual Historian Points.
The Add Historian Points dialog box appears.

4. In the Add points to server list, select the FactoryTalk
Historian SE server to which you want to add the points.

5. In the respective lists, select the data collection interface,
default scan rate, and tag attributes for new points.

6. Click Browse Tags. The Tag Browser dialog box
appears.

7. In the Tag Browser dialog box, select the folder from
which you want to collect data points. The data points
from the selected folder are displayed in the right pane of
the dialog box.

8. Select the data points that you want to add, and click Add
Tag(s) to List. The tags appear in the Selected tag(s) list
at the bottom of the Tag Browser dialog box.

Adding individual data 
points manually 
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9. Click OK until you return to the FactoryTalk
Administration Console.

The point discovery wizard uses discovery rules to search for 
Historian points. Creating the rules is a part of the discovery 
process. The data points (tags) that match the rules you create 
are added to the FactoryTalk Historian SE server. The default 
rules are stored in the following XML file: 

C:\ProgramData\Rockwell Automation\FactoryTalk 
Historian\Auto Discovery and Configuration Rules.xml 

The rules that you define are saved in a user-defined XML file. 
The file is stored in the same location as the file with the default 
set of rules. The point discovery wizard uses the rules from both 
files. However, the rules defined in the user-defined XML file 
take precedence over the rules defined in the default XML file. 

To automatically discover Historian points with the wizard: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, choose
the Network directory that you want to use, and click OK.

3. In the Explorer tree, right-click the application or area
from which you want to search for data points, and select
Discover Historian Points. The Discover New Historian
Points dialog box appears.

NOTE For more information on the point discovery
wizard, click the help icon in the Discover New 
Historian Points dialog box. 

4. In the Add points to server list, select the FactoryTalk
Historian SE server to which you want to add the points.

Adding multiple data 
points automatically 
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5. In the Using data collection interface list, select the
appropriate data collection interface.

6. In the Default scan rate list, select the time interval at
which points will be collected.

7. Under Add points from these sources, select the sources
from which you want to add the points.

8. Under Start searching from, click the tree at the starting
point for the point search. If this is a new server, the root
node in the tree is selected by default.

9. Click Edit Discovery Rules to create rules to be used
during the discovery process. The FactoryTalk Historian
Discovery Rule Editor dialog box appears.

NOTE For more information on the Discovery Rule
Editor click the help icon in the dialog box. 

10. Select Enable data type filter to perform the search using
the default discovery rule.

NOTE When you check the Enable data type filter
option, the auto-discovery mechanism will get 
all attributes that match the name, UDT, and 
data type rule. When you leave the option 
cleared, the mechanism will ignore the data 
type filter and only check the name and the UDT 
rule. 

11. Click Next to begin discovering points. The Discovering
Historian Points dialog box displays the progress of point
discovery.
The discovered points are listed in the Confirm New
Historian Points dialog box.

12. Click Confirm Points to accept the search result.
13. In the New Historian Points Discovery Complete dialog

box, click Start. The FactoryTalk Historian SE server
starts collecting the discovered points.

14. Click OK.
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You can view current and archive data using System 
Management Tools. In this section you will learn how to: 

• View current data (page 121).

• View archive data (page 121).

To view current data being collected by the FactoryTalk 
Historian SE server: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the FactoryTalk
Historian SE server whose data you want to view.

3. Under System Management Tools, select Data >
Current Values.

4. On the Tools menu, click Tag Search.
The Tag Search dialog box appears.

5. Use the default settings and click Search.
6. From the list of tags that appears in the search results,

select the tags you want to view, and click OK. The
current values of the tags are displayed in the right pane of
the System Management Tools dialog box.

If you want the server to start updating the values for the 
tag, right-click it and select Start Updating Values. 

To view archive data that has been collected by the 
FactoryTalk Historian SE server: 

View current and 
archive data 

View current data 

View archive data 
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1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the FactoryTalk
Historian SE server whose data you want to view.

3. Under System Management Tools, select Data >
Archive Editor.

4. In the (Tag Not Specified) tab, click .
The Tag Search dialog box appears.

5. Use the default settings, and click Search.
6. From the list of tags that appears in the search results,

choose one of the tags you have selected in "Adding
individual data points manually (page 118)", and click
OK.
The list of events of the selected tag is displayed in the tab
in the right pane of the System Management Tools dialog
box.

NOTE For more information on the Archive Editor,
click . 

7. Verify that the system has returned archived values, and
close the System Management Tools.

After you have installed and verified the Historian server, 
configure your Historian server automatic daily backups. You 
must specifically schedule a backup task on the Historian 
server. 

TIP For more information on configuring automatic 
backups, refer to PI Data Archive 2018 SP3 
Introduction to System Management Guide, chapter 
"Back up PI Data Archive". 

Historian Archive files store the historical record of process data 
maintained by the Historian server. By default, the Historian 
server setup program creates one archive file. Make sure that the 

Archives and backups 
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location of the archive directory contains enough free space for 
these files. 

For new installations, the installation wizard calculates the 
default archive size based on the physical memory that is 
available on the computer. The recommended archive size will 
equal approximately one-third of the physical memory. It will 
also never be smaller than 256 MB or greater than 8192 MB. 
The actual recommendation will always be a power of 2. 

Example 

The physical memory available on the computer equals 8192 
MB. 

One-third of it equals 2730 MB. 

The result will be rounded down to 2048 MB, which is a power 
of 2. 

Conclusion: The recommended archive size on a computer with 
8192 MB of the physical memory equals 2048 MB. 

The default archive file size might be too small for most 
systems. Rockwell Automation recommends that you change 
the default size based on the number of Historian Points, 
according to the recommendations in the PI Data Archive 2018 
SP3 Introduction to System Management Guide. 



Chapter 5 Configuring FactoryTalk Historian 

124 Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 

NOTE The complete user documentation on FactoryTalk
Historian SE is divided into individual suites and is 
available in the following subfolders of the Common 
Files\Rockwell\Help folder in your Program Files 
(x86) directory: 
• FactoryTalk Historian SE <version> Server
• FactoryTalk Historian SE <version> Management

Tools
• FactoryTalk Historian SE <version> Asset

Framework
• FactoryTalk Historian SE <version> Live Data

Interface
• FactoryTalk Historian SE <version> Analysis Service

The documentation is also available in the 
Redist\Docs folder on your FactoryTalk Historian SE 
installation media. 

The location for archives is typically on the largest drive on the 
server. 

NOTE Use the Windows File System Compression feature
with caution; it might slow down the access of the 
Historian server to archive files. The compression can 
save disk space, but it requires more CPU resources. 

NOTE You need administrative rights to perform these
steps. 

To restart the server: 

1. Stop the server:
a) Search for Stop FactoryTalk Historian SE in

Windows Search, right-click it, and then select Run as
administrator.
The server stopping process begins. The progress is
displayed in the Command Prompt window.

Restart the FactoryTalk 
Historian SE server 
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b) Wait until the server is stopped and the Command
Prompt window is closed.

2. Start the server by searching for Start FactoryTalk
Historian SE in Windows Search, right-clicking it and
then selecting Run as administrator.
The server starting process begins. The progress is
displayed in the Command Prompt window.

3. Wait until the server is started and the Command Prompt
window is closed.

Use the FactoryTalk Administration Console to configure the 
data server by adding new applications, areas, data server 
instances, and shortcuts to controllers. 

To configure the data server: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.
Under Explorer, the tree of the FactoryTalk Directory you
have selected using the FactoryTalk Directory Server
Location Utility (page 31) is displayed.

2. On the Help menu, click Contents to open FactoryTalk
Help and learn more about configuring the data server.

NOTE Refer to the information on configuring Historian
interface connections in PI-Data-Archive-2018-SP3-
Security-Configuration-Guide-EN.pdf for details 
associated with the following procedure. For 
information on the location of the user documents, 
see "User documentation (page 17)". 

To configure your Historian server to provide access for 
Historian Interfaces: 

Configure the data 
server 

Configure Historian 
interface connections 
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1. Identify all the Historian Interfaces that need access to the
Historian server.

2. Consult the documentation for each interface and gather
the information you need to configure the trust. You need
to know the connection type. The type of connection
determines what information you can use to define the
trust. You also need to specify at least one of the
following:

• The correct application name to define the trust.

• IP information for the connecting computer.
3. Decide how many trusts you will create. You can create

explicit individual trusts for each Historian interface, or
you can group them by subnet, host machine, or user
name. A group of Historian interfaces can share the same
privileges.

4. For each trust, create a PI identity.
5. Give that PI identity all the access permissions required by

the trust.
6. Create a trust based on that PI identity.

The interface collects data points (tags) from the data server and 
passes them to the FactoryTalk Historian SE server. Install the 
FactoryTalk Historian Live Data Interface component on the 
same computer as the data server. After installing the interface, 
configure the buffering service on the data server computer. The 
buffering service stores data in its buffer so that in the event the 
interface is not able to communicate with the FactoryTalk 
Historian SE server, the data will not be lost. 

In this section you will learn how to: 

• Create security mappings for remote interfaces (page 127)

• Set up connection between the FTLD interface and the
FactoryTalk Historian SE server computers (page 127)

• Register Live Data interfaces (page 129)

Configure FactoryTalk 
Historian Live Data 
Interface 
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• View the status of Live Data interface services (page 131)

• Verify that points are being collected (page 127)

• Enable buffering (page 132)

In the FactoryTalk Historian SE security model, in order to give 
a Windows user privileges from several Historian groups, you 
need to create mappings using the System Management Tools 
following either of the methods: 

• Create a mapping between an Active Directory (AD)
group and a Historian user. In this way, the Windows user
from the AD group used in the mapping gets privileges
from all the Historian groups to which the Historian user
referred to in the mapping belongs.

• Create 1-to-1 mappings between each AD group and a
corresponding Historian group. If the Windows user is a
member of only one AD group for which you have created
the mapping, they will get privileges only from the
Historian group referred to in the mapping. If you want the
Windows user to get privileges from several Historian
groups, make sure the user is a member of all the AD
groups that are mapped to the Historian groups whose
privileges the user should get.

Security mappings are required to establish connections 
between the FactoryTalk Historian SE server and any remote 
computer that should be able to communicate with the server 
(such as the Data Server, the Engineering Workstation, and/or 
Client Computers). 

To create a security mapping between a Windows user 
and/or group and a Historian server user: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

Create security 
mappings for remote 
interfaces 
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2. Under Collectives and Servers, select the FactoryTalk
Historian SE server for which you want to create the
mapping.

3. Under System Management Tools, select Security >
Mappings & Trusts.

4. 4. In the Mappings tab, click .
The Add New Mapping dialog box appears.

5. Click  next to Windows Account.
The Select User, Computer, or Group dialog box
appears.

6. In the text box, type the name of the user, for which you
want to create the mapping.

7. Click Check Names to verify the user name, and click
OK.

8. Click  next to PI Identity.
The Select PI Identity, PI Group, or PI User dialog box
appears.

9. From the Type list, select PI Users.
10. Select the PI user to which you want to map the selected

Windows user (e.g., piadmin), and click OK.
11. Click OK to apply the changes. The new mapping is listed

in the Mappings tab.
Perform these steps on your FTLD interface computer(s). Log 
on to the computer using the user for which you have created 
the security mapping. For details, see "Create security mappings 
for remote interfaces" (page 127). 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under System Management Tools, go to Connections.

Set up a connection 
between the FTLD 
interface and the 
FactoryTalk Historian 
SE server computers 
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3. Select the FactoryTalk Historian SE server to which you
want to connect.
If the server name is not listed, do the following:
a. On the Server menu, click Add Server. The Add

Serve dialog box appears.
b. In the Network Node text box, type the fully

qualified domain name (FQDN) of the server.
c. Clear the Confirm check box, and click OK. The

new server is added to the server list.

When you create a Historian server connection in the 
FactoryTalk Administration Console (page 98), a default Live 
Data interface instance FTLD1 is created and registered. 

If your Live Data interface is located on a remote computer, you 
need to register this interface as well. 

Before you begin: 

1. Create security mappings for your remote interfaces (page
90).

Register Live Data 
interfaces 
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2. Set up connection between the FTLD interface and the
FactoryTalk Historian SE server computers (page 127).

To register a remote FactoryTalk Historian Live Data 
Interface: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, click
Network.

3. In the Explorer tree of the FactoryTalk Administration
Console dialog box, go to System > Connections >
Historical Data, right-click the FactoryTalk Historian
server connection name, and select New Data Collection
Interface.
The Data Collection Interface Properties dialog box
appears.

4. In the Computer hosting the interface list, select the
name of the computer on which you have installed the data
server and the FactoryTalk Historian Live Data Interface.

5. From the Startup Type list, choose Automatic.
6. Click Apply.
7. Click Start to start the data collection service. Wait until

the service status changes to Started.

8. Click OK.
The new Live Data interface instance is added to the
server connection branch.
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For each instance of the FactoryTalk Historian Live Data 
Interface, a service (FTLD) is created and started when you start 
the interface. You define the service startup type (page 129) in 
the Data Collection Interface Properties dialog box in the 
FactoryTalk Administration Console. 

To view the status of the services, open the Services dialog box. 

The services are removed when you delete the interface 
instances in FactoryTalk Administration Console. 

Follow these steps after you set up or upgrade your FactoryTalk 
Live Data interface. The steps should be performed on the 
FactoryTalk Historian SE server computer or the engineering 
workstation computer. 

To verify that points are being collected: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under System Management Tools, expand Data >
Current Values.

View the status of Live 
Data interface services 

Verify that points are 
being collected  
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3. In the right pane, verify that points are logging data. For
the verification, choose the point that:

• Had been created before you set up your FactoryTalk
Live Data interface.

• Have the scan setting turned on.

• Their values change frequently on the controller.

NOTE If you want to take advantage of the buffering
feature, Rockwell Automation recommends that you 
install the FactoryTalk Historian Live Data Interface 
on a remote computer, typically the computer where 
the data server is installed. 

The buffering subsystem stores time-series values to the buffer 
when the remote interface computer cannot communicate with 
the FactoryTalk Historian SE server. 

NOTE FactoryTalk Historian SE supports the PI Buffer
Subsystem only. It does not support the API Buffer 
Subsystem. 

Before you begin: 

1. Create security mappings for your remote interfaces (page
90).

2. Set up connection between the FTLD interface and the
FactoryTalk Historian SE server computers (page 127).

The process of enabling the buffering on the computer with the 
FactoryTalk Historian Live Data Interface (FTLD interface) 
installed consists of the following steps: 

1. Verify that there is a buffering trust created (page 133)
2. Run the first-time buffering configuration (page 133)
3. Specify the FactoryTalk Historian SE that will receive the

buffered data (page 137)
4. Configure the FTLD service (page 139)

Enable buffering 



Configuring FactoryTalk Historian Chapter 5 

133 

5. Verify that buffering is working correctly (page 141)

NOTE If you want to configure a remote FactoryTalk
Historian Live Data Interface to start from a local 
cache file with or without a valid connection to the 
host FactoryTalk Historian Server, enable the 
Disconnected Startup feature. For more information, 
refer to KB article 66883. 

During the installation of the FactoryTalk Historian SE server a 
PIBuffSubSystemService trust is created for the buffering 
purposes. 

To verify that there is a buffering trust created: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under System Management Tools, expand Security >
Mappings & Trust.

3. Verify that PIBuffSubSystemService is listed in the
Trusts tab.

Verify that there is a 
buffering trust created 

Run the first-time 
buffering configuration 

Rockwell Automation Publication HSE-IN025F-EN-E–September 
2020 
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To run the first-time buffering configuration: 

1. In the System Management Tools, on the Tools menu,
click Interface Configuration Utility.
The Interface Configuration Utility dialog box appears.

2. From the Interface list, select the name of the FactoryTalk
Historian Live Data Interface.

3. On the Tools menu, click Buffering. The following
message appears:

4. Click Yes, and then follow the listed screenshots.

5. 

6.
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7. Under PI Data Archive Security, configure a trust
between the FTLD interface and the FactoryTalk Historian
SE server that will receive the buffered data.
Clear the Client name and the IP address check boxes.

8. 

9.
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10. 

11.
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12. 

To specify the FactoryTalk Historian SE that will receive 
the buffered data: 

1. In the Interface Configuration Utility, on the Tools
menu, click Buffering.
The Buffering Manager window appears.
In the Interface Configuration Utility, under PI Host
Information, the Buffering Status box appears with the
status Off.

2. Click Enable.

The Buffering Manager - Add Data Server Wizard 
window appears. 

3. Under Server Selection, in the Server box, do either of
the following:

• Type the server name.

Specify the FactoryTalk 
Historian SE that will 
receive the buffered 
data 
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• Click Browse next to the box, and then select the FTLD
interface .bat file.
The name of the file is the name of the interface (for
example FTLDInt1.bat).
The file is located in the following location:
...\Program Files (x86)\Rockwell Software\FactoryTalk
Historian\PIPC\Interfaces\LDInterface\

4. Under PI Data Archive Security, configure a trust
between the FTLD interface and the FactoryTalk Historian
SE server that will receive the buffered data.
Clear the Client name and the IP address check boxes.
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5. 

6. 

To configure the FTLD service: 

1. Close the Interface Configuration Utility, and then open
it again.

2. Select your FTLD interface from the list. The buffering
status is now set to On.

Configure the FTLD 
service 
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3. In the left pane of the window, click Service. Under
Service Configuration, in the Dependencies box, the
PIBufss service should be listed:

• If it is, the configuration is complete.

• If it is not, the following message appears, Click Yes.
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Verify that buffering is working correctly: 

1. In the Interface Configuration Utility, on the Tools
menu, click Buffering. The Buffering Manager window
appears.
Buffering should be running, and the number of events in
queue should equal 0 or be close to 0:

2. Open a Command Prompt window and run the following
command:
pibufss -bc stop

Once the command is executed, sending data to the
specified FactoryTalk Historian SE server is stopped. The
number of the events in queue should increase, while the
total number of events should stay unchanged:

Verify that buffering is 
working correctly 
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3. In the Command Prompt window and run the following
command:
pibufss -bc start

Once the command is executed, sending data to the
specified FactoryTalk Historian SE server is started. The
number of the events in queue should equal 0 or be close
to 0, and the total number of events should continue to
increment:
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NOTE In order to use the functionality provided with the
add-ins, make sure that all the add-ins that you want 
to use are registered in Microsoft Excel. 

To enable Excel add-ins for FactoryTalk Historian 
DataLink: 

1. Start Microsoft Excel.
2. Select File > Options.

The Excel Options dialog box appears.
3. Click Add-Ins.
4. At the bottom of the page, from the Manage list, select

Excel Add-ins, and click Go.
The Add-Ins dialog box appears.

5. Click Browse.
The Browse dialog box appears.

Enabling Excel add-ins 
for FactoryTalk 
Historian DataLink 
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6. In the path box, type %PIHOME%, and then press
Enter:

The variable points to the location of the PIPC folder. 
Because the location of the PIPC folder differs depending 
on the type of the operating system that you use (32-bit or 
64-bit) and the client version, by typing the %PIHOME%
variable, you open the PIPC folder from the correct
location.

7. In the PIPC folder, open the Excel folder. This folder
contains the following files:

• pidldialogs.xla

• PITrendXL.xla

• pipc32.xll (for the 32-bit installation)

• pipc64.xll (for the 64-bit installation)

NOTE The PI Tag Configuration add-in (PITagCnf.xla) is now
replaced with PI Builder. PI Builder must be installed 
manually using the PI-Server_2018-SP3-Patch-1_.exe 
file located at \Redist\PIServer\. PI Builder requires 
Excel 2010 SP2 or later. 

8. Select one file at a time, and then click OK. Each file that
you select is added to the Add-Ins available list.

9. Click OK to close the dialog box.
The tabs with the selected Excel add-ins are added to the
ribbon in Excel.

If you want to use tag functions, module database objects, or 
trends in FactoryTalk Historian DataLink, activate the DataLink 
COM add-ins in Microsoft Excel first. 

Activating Excel COM 
add-ins for FactoryTalk 
Historian DataLink 
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To activate COM add-ins in Microsoft Excel: 

1. Start Microsoft Excel.
2. Select File > Options. The Excel Options dialog box

appears.
3. Click Add-Ins.
4. At the bottom of the page, from the Manage list, select

COM Add-ins, and then click Go.
The COM Add-ins dialog box appears.
Under Add-Ins available, find the following add-ins:

• PI DataLink

• PI DataLink (Legacy)
5. Check the box next to each add-in, and then click OK.

The add-ins are activated and their tabs are added to the
ribbon.

FactoryTalk Historian SE uses the FactoryTalk Diagnostics 
component of the FactoryTalk Services to record messages sent 
by the FactoryTalk Historian SE server. In the event of a 
message, the FactoryTalk server logs it in the FactoryTalk 
Diagnostics service. 

If the FactoryTalk Historian SE server cannot connect to the 
FactoryTalk Diagnostics service, the server will log the 
messages in the Windows Event log and continue to reconnect 
to FactoryTalk Diagnostics service. Once the server reconnects 
to the FactoryTalk Diagnostics service, a message is logged 
indicating that some messages may not have been logged and 
will advise you to check the local Windows Event log. 

Recording messages 
using FactoryTalk 
Diagnostics 
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Each message logged to the FactoryTalk Diagnostics service 
contains the following information: 

Item name Description 

Date/Time The date and time the message was recorded. The 
time is the local time of the server. This is 
important to note if you are in a different time 
zone than the server. 

User Name The name of the user that performed or requested 
an operation that generated the error message. 
Note: If you plan to track user IDs in FactoryTalk 
Diagnostics for auditing purposes, you must 
create identical user IDs in the FactoryTalk 
Historian SE. Refer to PI-Data-Archive-2018-SP3-
System-Management-Guide-EN.pdf for 
information on creating user IDs in the Historian 
server. 

User 
Description 

The full name of the user. 

Severity All messages are logged as Warning or 
Informational. 

Audience Engineer is the default audience type for all 
messages. 

Message text A description of the error that occurred. 
Location The name of the computer where the diagnostic 

message was generated. 
Provider The name of the FactoryTalk product or 

subsystem that generated the message. 

TIP For information on the location of the user 
documents, see "User documentation (page 17)". 

To view the messages in FactoryTalk Diagnostics, run the 
FactoryTalk Diagnostics Viewer tool. See the FactoryTalk 
Diagnostics Viewer Help for more information. 

Understand message 
parameters 

Viewing messages 
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To view messages stored in the Windows Event log, open Event 
Viewer. 

TIP To learn how to open Event Viewer, see "Opening 
Event Viewer on Windows Server (page 147)". 

To open Event Viewer using your Start menu, enter Event 
Viewer and select the Event Viewer result.  

Opening Event Viewer 
on Windows Server  
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Chapter 6 

Troubleshooting FactoryTalk 
Historian 

In this chapter you will learn how to: 

• Use FactoryTalk Historian ME modules with FactoryTalk
Security (page 149).

• Verify the Windows Administrator privileges (page 151).

• Resolve error and warning messages (page 151).

If you are using FactoryTalk Security to authenticate your 
FactoryTalk Historian ME 1756-HISTxG module, and you want 
to establish a connection between the Historian ME and SE 
modules, you need to make sure the following FactoryTalk 
Security groups are created in FactoryTalk Directory: 

• FTHAdministrators

• FTHEngineers

• FTHSupervisors

• FTHOperators

To verify that these four user groups were created: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, select
Network, and click OK.

Using FactoryTalk 
Historian ME modules 
with FactoryTalk 
Security 
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3. In the Explorer tree, expand Users and Groups > User
Groups.
The folder should include the four FactoryTalk Historian
user groups:

If you do not see the four user groups, do the following on the 
FactoryTalk Directory server computer: 

1. Log on to Windows as the local Administrator.
2. Log on to FactoryTalk as a member of the FactoryTalk

Administrators user group.
3. Open the FactoryTalk Administration Console, and

create a computer account for each FactoryTalk Historian
SE host.

4. On your FactoryTalk Historian SE installation media,
navigate to Redist > FTHME Security.

5. Double-click the FTHMESecurityUpdate.bat file.
6. Return to FactoryTalk Administration Console and

verify that the user groups have been created.
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To verify that the Windows Administrators group is part of 
the FTHAdministrators group: 

1. In FactoryTalk Administration Console, expand Users
and Groups > User Groups.

2. Double-click the FTHAdministrators group.
The FTHAdministrators Properties dialog box appears.
The Windows Administrators group should appear in the
Members list. If it does not, do the following:

a. Click Add. The Select User or Group dialog box
appears.

b. Select Windows Administrators and click OK. The
group is added to the FTHAdministrators group.

c. Click OK to close the dialog box.

Use this section to find information about the following types of 
error and warning messages: 

• General (page 151)

• No connection to FactoryTalk Directory (page 154)

• Firewall-related errors (page 156)

Use this section to find information about the following error 
messages: 

• Error: system is a PINs node (page 152)

• Error: server not found (page 152)

• Error: failure to retrieve interface information (page 153)

Verifying the Windows 
Administrators 
privileges 

Resolving error and 
warning messages 

General 
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Message FactoryTalk Historian SE server setup has 
determined that this is a PINS node. The 
FactoryTalk server installation cannot continue. 
Please completely remove the Historian SDK and 
rerun setup. 

Cause The error occurs if you install a FactoryTalk 
Historian SE server on a computer that already 
has FactoryTalk Historian SE Clients 
(ProcessBook, DataLink) or components (System 
Management Tools) installed. 

Resolution Remove the Historian Software Development Kit 
(Historian SDK) using Control Panel > Programs > 
Programs and Features. 

Message The requested server <FTHSE-SRV> was not 
found in the known servers table. 

Cause The error occurs when you try to create a new 
Data Collection Interface from a computer that 
has FactoryTalk Historian SE Live Data Interface 
installed. Your client computer could not locate 
the FactoryTalk Historian SE server. 

Resolution Manually create a connection to the FactoryTalk 
Historian SE server computer. See the following 
instructions. 

To manually create a connection to the FactoryTalk 
Historian SE server computer from your client computer: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

Error: system is a PINs 
node 

Error: server not found 
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2. In the System Management Tools, go to Connections:

3. Select the FactoryTalk Historian SE server to which you
want to connect.
If the server name is not listed, do the following:

a. On the Server menu, click Add Server. The Add
Server dialog box appears.

b. In the Network Node text box, type the fully
qualified domain name (FQDN) of the server.

c. Clear the Confirm check box, and click OK. The
new server is added to the server list.

Message Failure to get/update interface information 
because the Historian MDB content was bad. 

Cause The error occurs if, during an upgrade, you 
manually remove the earlier version of 
FactoryTalk Historian SE server using Control 
Panel > Programs > Programs and Features. 

Resolution Delete the FTLD1 interface and create it again. 
See the following instruction. 

Error: failure to retrieve 
interface information 
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To delete the FTLD1 interface: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. In the Select FactoryTalk Directory dialog box, select
Network, and click OK.

3. In the Explorer tree, expand System > Connections >
Historical Data, and the FactoryTalk Historian SE server
node.

4. Right-click FTLD1 and select Delete.
5. Click Yes in the confirmation message box.
6. Right-click the FactoryTalk Historian SE server and select

New Data Collection Interface to create a new interface.

NOTE: During upgrades, use the installation media to
install the latest version of FactoryTalk Historian 
SE server. The older version is removed during the 
setup procedure. 
Avoid removing the FactoryTalk Historian SE 
server with Control Panel > Programs > Programs 
and Features. 

Use this section to find information about the following warning 
messages: 

• Schema creation (page 155)

• Folders creation (page 156)

No connection to 
FactoryTalk Directory 
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Message Due to the lack of connection to the network, 
some of the FactoryTalk Historian components 
have not been correctly configured. 

Cause The warning occurs if you try to create the schema 
in the FactoryTalk Directory when your client 
computer is not connected to the network. 

Resolution Manually create a connection to the FactoryTalk 
Directory and add the schema information. See 
the following instruction. 

To add the schema information to the FactoryTalk Directory, 
we recommend that you execute the 
FTHMESecurityUpdate.bat file. It is located in the 
Redist\FTHME Security directory on your FactoryTalk 
Historian SE installation media. The file automatically adds 
schema information and folders to the FactoryTalk Directory on 
your client computer. 

To manually add the schema information to the 
FactoryTalk Directory: 

Open the Command Prompt window and type the following: 

"[ProgramFilesFolder]Rockwell Software\Management 
Tools\FTHistorianInstallSetup.exe" 
"[CommonAppDataFolder]Rockwell Automation\FactoryTalk 
Historian\FTHistorianSchema.xml" 
"[CommonAppDataFolder]Rockwell Automation\FactoryTalk 
Historian\FTHistorianStrings.xml" -G, 

where: 

• [ProgramFilesFolder] is the Program Files (x86) directory
(e.g., C:\Program Files (x86)).

• [CommonAppDataFolder] is the ProgramData directory (e.g.,
C:\ProgramData).

Schema creation 
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Message Due to the lack of connection to the network, 
some of the FactoryTalk Historian components 
have not been correctly configured.  

Cause The warning occurs if you try to create new folders 
in the FactoryTalk Directory when your client 
computer is not connected to the network. 

Resolution Manually create a connection to the FactoryTalk 
Directory and add folders. See the following 
instructions. 

To add the schema information to the FactoryTalk Directory, 
we recommend that you execute the 
FTHMESecurityUpdate.bat file. It is located in the 
Redist\FTHME Security directory on your FactoryTalk 
Historian SE installation media. The file automatically adds 
schema information and folders to the FactoryTalk Directory on 
your client computer. 

To manually add folders to the FactoryTalk Directory: 

Open the Command Prompt window and type the following: 

"[ProgramFilesFolder]Rockwell Software\Management 
Tools\FTHistorianInstallSetup.exe" 
"[CommonAppDataFolder]Rockwell Automation\FactoryTalk 
Historian\FTHistorianFolders.xml" -G, 

where: 

• [ProgramFilesFolder] is the Program Files (x86) directory
(e.g., c:\Program Files (x86)).

• [CommonAppDataFolder] is the ProgramData directory (e.g.,
c:\ProgramData) on your client computer.

During the installation, the FactoryTalk Historian suites attempt 
to update the configuration of the system firewall using the 
Rockwell Firewall Configuration Utility (WFCU) that has been 
installed along with FactoryTalk Services. 

Folders creation 

Firewall-related errors 
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If the update of the firewall configuration cannot be completed 
during the installation, a relevant error message is displayed on 
the last page of the FactoryTalk Historian installation wizard. 

The errors fall into the following categories, depending on the 
firewall configuration you have: 

• The errors that may appear if you use Windows Firewall to
configure network security on the computer with
FactoryTalk Historian installed:

Error number Description 

20 The user has insufficient permissions to 
modify Windows Firewall rules. 

200 The user has declined to make the changes 
to the configuration of Windows Firewall. 

320 The network connection specified in WFCU 
could not be found. 
Cause: No network connection is 
configured. 
Resolution: Configure the network 
connection and then configure Windows 
Firewall. 

See "Configuring Windows Firewall with WFCU (page 
158)" for details. 

• The errors that may appear if you use another firewall
utility to configure network security on the computer with
FactoryTalk Historian installed:

Error number Description 

10 The version of Windows Firewall is not 
supported by WFCU. 

100 Some parameters of the WFCU configuration 
are missing. 

110 Some parameters of the WFCU configuration 
are incorrect. 
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Error number Description 

120 The .WFCU file contains incorrect data. 
130 The .WFCU file is missing. 
300 The configuration of Windows Firewall is not 

supported by WFCU. 
310 The .WFCU file contains incorrect 

configuration settings. 
400 The Microsoft Firewall service is stopped. 
-999 Rockwell Windows Firewall Configuration 

Utility (WFCU) could not be found. 

See "Configuring Windows Firewall for FactoryTalk 
Historian (page 95)" for details. 

If the error message does not contain the error number, refer to 
the FactoryTalk Historian log for the error details. 

NOTE You need administrator privileges to perform the
following steps. 

TIP If you prefer, you may manually configure the firewall 
settings described here (page 95). 

To automatically configure Windows Firewall with WFCU: 

1. Go to the computer on which you have the particular
Historian suite installed.

2. Check the location of the Common Files folder on the
computer for the 32-bit operating system. You will need it
in the command line.

3. Open the Command Prompt window.
4. Type the command provided in the following table.

Configuring Windows 
Firewall with WFCU 
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For this FactoryTalk Historian 
suite: 

Run these commands: 

Historian to Historian Interface %COMMONFILESFOLDERX86%\Rockwell\WFCU\wfcu.exe -I 
"%COMMONFILESFOLDERX86%\Rockwell\WFCU\FTH2HInt
erface.wfcu" 

Asset Framework %COMMONFILESFOLDERX86%\Rockwell\WFCU\wfcu.exe -I 
"%COMMONFILESFOLDERX86%\Rockwell\WFCU\FTHistoria
nSEAF.wfcu" 

Historian Server %COMMONFILESFOLDERX86%\Rockwell\WFCU\wfcu.exe -I 
"%COMMONFILESFOLDERX86%\Rockwell\WFCU\FTHistoria
nSEServer.wfcu" 

Live Data Interface %COMMONFILESFOLDERX86%\Rockwell\WFCU\wfcu.exe -I 
"%COMMONFILESFOLDERX86%\Rockwell\WFCU\FTHistoria
nSELiveDataInterface.wfcu" -s 

The %COMMONFILESFOLDERX86% variable stands for 
the location of the Common Files folder on the computer. 
Example: If the Common Files folder is in the following 
location: 
C:\Program Files\Common Files\ 
The complete path to the command that you need to run 
for the Historian to Historian Interface is: 
C:\Program Files\Common 
Files\Rockwell\WFCU\wfcu.exe -I "C:\Program 
Files\Common 
Files\Rockwell\WFCU\FTH2HInterface.wfcu" 

5. Press Enter.
The firewall is configured.
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Appendix A 

Appendix A: Configuring 
Historian servers in high 
availability mode 

In this chapter you will learn about the following: 

• High availability (HA) architecture (page 161).

• Working with server collectives (page 163).

• Creating server collectives (page 164).

• Configuring Windows firewall for collectives (page )

• Verifying communication between server collective
members (page 167).

• Verifying replication of configuration changes in the
primary server (page 169).

• Assigning license activations to server collectives (page
170).

• Configuring interfaces and buffering services for Historian
server collectives (page 174).

• Opening Collective Manager on Windows Server (page
175)

NOTE For detailed information on the high availability
functionality, refer to the High-Availability-
Administrator-Guide_EN.pdf. For information on 
the location of the user documents, see "User 
documentation (page 17)". 

You can configure high availability (HA) features on 
appropriate Historian components. To ensure the high 

High availability (HA) 
architecture 
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availability of FactoryTalk Historian server data, you must 
configure three types of components: 

• A FactoryTalk Historian server collective
To implement HA, install two FactoryTalk Historian
servers and configure the FactoryTalk Historian SE system
to store and write identical data on each server. Together,
this set of servers, called a FactoryTalk Historian server
collective, acts as the logical FactoryTalk Historian server
for your system. The server collective receives data from
one or more interfaces and responds to requests for data
from one or more clients. Because more than one server
contains your system data, system reliability increases.
When one server becomes unavailable, for planned or
unplanned reasons, another server contains the same data
and responds to requests for that data. Similarly, when the
demand for accessing data is high, you can spread that
demand among the servers.

• Redundant interfaces
To implement HA, configure interfaces to support failover
and n-way buffering:

• Failover ensures that time-series data reaches the
FactoryTalk Historian server even if one interface fails.
To support failover, install a redundant copy of an
interface on a separate computer. When one interface is
unavailable, the redundant interface automatically starts
collecting, buffering, and sending data to the
FactoryTalk Historian server.

• N-way buffering ensures that identical time-series data
reaches each FactoryTalk Historian server in a
collective.
To support n-way buffering, configure the buffering
service on interface computers to queue data
independently to each FactoryTalk Historian server in a
collective.
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• Clients (user workstations)
To implement HA, configure clients to connect to either
server in a collective and seamlessly switch to another
server if necessary.

A server collective consists of two FactoryTalk Historian SE 
servers (primary and secondary) that have the same 
configuration database. This provides the same association 
between the key values in the FactoryTalk Historian SE tables 
on all of the servers. This also ensures that the archive data files 
have the same structure on all of the servers. 

Working with server 
collectives 
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Keep the following in mind about server collectives: 

• When creating server collectives, you must always use
fully qualified host names, not IP addresses. Therefore, the
name resolution functionality must work on the network.

• If you make one or more FactoryTalk Historian SE servers
members of a collective, you must restart them after a
server collective is created. Otherwise, FactoryTalk
Administration Console will not recognize any of the
third-party tag licenses you may have on your servers.

• To create a server collective on computers that have
Windows Firewall turned on, you must manually open the
TCP 445 port between the two computers. Please refer to
the Microsoft documentation for more information.

• The Windows user that configures server collectives must
be a domain user and must be mapped to the piadmin user.
See "Create security mappings (page 90)" for more
information.

• The same Windows user to piadmin user mapping must be
performed on both the primary and secondary server in a
collective.

• Activate your server collective in the FactoryTalk
Administration Console.

To create a collective: 

1. Open Collective Manager. See Opening Collective
Manager on Windows Server (page 175).
The Collective Manager dialog box appears.

2. On the File menu, click Connections.
The Connection Manager dialog box appears.

3. On the Server menu, click Add Server.
The Add Server dialog box appears.

Creating server 
collectives 
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4. In the Network Node text box, type the name of the other
server that you want to add to your collective.

5. Click OK, and then Save.
6. On the File menu, click Create New Collective.

The Create New Collective wizard appears.

7. Select both check boxes, and then click Next.
8. On the Existing Or New Primary page, select A newly

installed server, and click Next.
The Select Primary and Collective Name page appears.

9. Review the following for additional information.

Item name Description 

Collective 
Primary 

From the list, select the name of the server 
you want to make primary. If the name is 
not in the list, click , and select the server 
from the Connection Manager dialog box. 

Primary 
Description 

(Optional) Type a description of the primary 
server. 

Collective 
Name 

Type a name of the collective. The name 
must be unique. 

Collective 
Description 

(Optional) Type a description of the 
collective. 

10. Click Next.
The Select Secondary Servers page appears.
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11. From the Server list, select the name of the server you
want to add as secondary.
If the name is not in the list, click , and select the server
from the Connection Manager dialog box.

12. Click Add to add the selected server to the secondary
servers list, and click Next.

13. On the Select Archives page, select the archives from
your primary server which you want to copy to your
secondary server. We recommend that you back up all
your primary server archives onto your secondary server.
Click Next.

14. On the Select Backup Location page, leave the default
location, or click  and browse to the location to which
you want to back up the content of your primary server.

15. Click Refresh to check the space available in the selected
location. Make sure that the space available is larger than
the space required.
Click Next.

16. On the Verify Selections page, verify the collective data,
and click Next.
The Conversion Progress page displays the status and
individual steps of the conversion process. Wait until the
conversion is complete.

17. If the Server ID Mismatch dialog box appears, select
Accept the new ID, and click OK.

18. On the Finished page, click Finish. The new collective is
displayed in the Collective Manager dialog box.

TIP For more information on collectives, refer to the 
Collective Manager Help. To access it, on the 
Help menu of the Collective Manager dialog 
box, click Contents. 
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You need to open specific TCP ports for a FactoryTalk 
Historian SE collective to be able to communicate through 
Windows Firewall. 

For details, see KB article 335447 in the Rockwell Automation 
Knowledgebase. 

Use the Collective Manager to verify that the members of your 
server collective are communicating. 

To check communication of the members of a server 
collective: 

1. Open Collective Manager. See Opening Collective
Manager on Windows Server (page 175).
The Collective Manager dialog box appears.
If the server collective does not appear under Collectives,
you must enable communication between the Collective
Manager and the collective:

a. In the System Management Tools, go to
Connections:

b. Click the check box next to the name of the server
collective to select it.

Configure Windows 
Firewall for collectives 

Verifying 
communication 
between server 
collective members 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/335447
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If the server collective is not listed in the Connection 
Manager, add it: 
1. Select Server > Add Server.
2. In the Network Node text box, type the fully

qualified domain name (FQDN) for the primary
server in the collective.

3. Click OK.
c. Select the server collective.
d. Click Save to close the Connection Manager.

2. Under Collectives, select your server collective.
The right pane of the dialog box displays the current status
of the connection between the members of the selected
server collective. The Collective Manager shows a
diagram of server collective members. An icon represents
each server in the collective. A green check mark on the
icon indicates that the server is communicating correctly.
A red x mark indicates that the server is not
communicating correctly.

If a server icon is not communicating correctly, you can: 

• Wait a few moments. Occasionally, the status of the
secondary server will get updated at the next attempt to
synchronize.

• Try to reinitialize the server. To do so, right-click the
server icon and select Reinitialize Server.

• Restart the primary and secondary server.
For details, see "Restart the Historian server" (page
185).
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To verify that a Historian server collective replicates primary 
server configuration changes to all secondary servers, you can 
edit a point on the primary server and verify the change on the 
secondary server in the collective. 

To verify configuration replication in a Historian server 
collective: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select all the servers that
are members in the collective.

3. Under System Management Tools, select Points > Point
Builder.

4. Add a point found in all the servers to the list of points:

1. On the toolbar, click . The Tag Search dialog box
appears.

2. In Tag Mask, type sinusoid.
3. Click Search to find all instances of this built-in point

on the selected servers.
4. Click Select All to choose all instances.
5. Click OK to add these points to the list of points in

the Point Builder.
5. Edit the point on the primary server:

a. Select the point on the primary server. The Point
Builder shows the configuration of the selected point
in the tabs at the bottom of the System Management
Tools dialog box.

b. In the General tab, change the text in the Descriptor
text box. For example, change 12 Hour Sine Wave to
12-hour sine wave.

c. Click . The Point Builder shows the updated
Descriptor text for this point on the primary server.

Verifying replication of 
configuration changes 
in the primary server 
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6. Click .
If the replication is working properly, the modified
Descriptor text appears for the sinusoid point on all the
servers in the collective.
If the replication fails, refer to the High-Availability-
Administrator-Guide_EN, section "PI Collective Health".
For information on the location of the user documents, see
"User documentation (page 17)".

NOTE In order to assign the activations to a FactoryTalk
Historian SE server, the server must be added to the 
FactoryTalk Directory. See "Adding the server to the 
FactoryTalk Directory (page 98)" for more 
information. 

Depending on the type of license activations, you may need to 
acquire a single or double number of license activations of a 
given type for your Historian server collective. 

• For the following license activations, you need a single
activation of a given type assigned to the Historian server
collective. A second unassigned activation is not required
(as it is for the point count activations):

• FHSE.Advanced

• FHSE ENTERPRISE

• FHSE.OLEDB

• FHSE.OPC

• FHSE.H2H

• FTBAInt.*

• AVIEW.*

NOTE The asterisk (*) stands for any count of FTBAInt
and AVIEW license activations. 

If you assign any of the license activations listed above to 
a Historian server collective, the primary server retrieves 
(checks out) the license activations from the FactoryTalk 

Assigning license 
activations to server 
collectives 
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Activation server to be used by both servers in a 
collective. In the FactoryTalk Activation Manager, the 
number of activations in use is reflected only for the 
primary server in a collective. It is because the assignment 
of activations to the secondary server in a collective is 
performed outside the FactoryTalk Activation mechanism. 
For example, if you want to assign 1 license activation of 
type FHSE.H2H to your Historian server collective, you 
need to acquire 1 license activation of this type and then 
assign it to the primary server in your collective. 

• For all other license activations, you need a separate
activation of a given type for each server in a collective.
If you assign any license activations other than those listed
above to a Historian server collective, the primary server
retrieves (checks out) the license activations from the
FactoryTalk Activation, and the second license activation
of the same type is automatically checked out for the
secondary server in a collective. In the FactoryTalk
Activation Manager, the number of activations in use is
reflected for both servers in the collective.
For example, if you want to assign 2 license activations of
type FHLD.5000 to your Historian server collective, you
need to acquire 4 license activations of this type and then
assign 2 activations to the primary server. The other 2
activations will be automatically assigned to the secondary
server in your collective. You will be able to assign license
activations of a given type to your server collective only if
you have a sufficient number of them available.

To assign license activations to the primary server in a 
collective: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.
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2. In the Select FactoryTalk Directory dialog box, select
Network, and click OK.

3. In the Explorer tree, expand System > Connections >
Historical Data.

4. Right-click the name of the server to which you want to
assign the license activations, and click Properties.

5. In the Historian Server Connection Properties dialog
box, click the Licensing tab. The table displayed in the tab
provides the following information for the selected server:

Item Description 

Activation The type of the license activation. 
Total The total number of license activations of 

the given type. 
In Use The number of license activations of the 

given type that are used by other Historian 
servers. 

Assigned The number of license activations of the 
given type that are assigned to the selected 
server. 

6. To assign a license activation to the server, type a number
in the Assigned column for the selected license activation.
The number shows how many licenses of the selected type
will be assigned to the server.

After each license activation assignment, the system 
checks the sum of points resulting from the assignments. 
The total sum of points must be equal to or less than 
500 000. If you exceed this limit, the following message 
appears: 
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Follow the instructions in the message. 
If you change the number of assigned license activations 
to a lower one, the system performs the following checks: 

• For license activations of type PTY3 and FHSE3ADD
The system checks the sum of limits for third-party
point sources currently set in the Point Sources tab. If
the sum exceeds the allowed limit for point sources
resulting from the number of relevant license
activations that are currently assigned to the Historian
server, an error message appears.

• For all license activations
The system checks the sum of limits for third-party
point sources and the FTMS point source currently set
in the Point Sources tab. If the sum exceeds the
allowed limit for point sources resulting from the
number of relevant license activations that are currently
assigned to the Historian server, an error message
appears.

For either of the two limit checks the following message is 
displayed: 



Appendix A Appendix A: Configuring Historian servers in high availability mode 

174 Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 

NOTE The following license activations are excluded
from the point limit check: AVIEW, FTBAInt, 
FHSE.H2H, FHSE.Advanced, FHSE.OLEDB, and 
FHSE.OPC. 

7. Click Apply.
If you have an insufficient number of the license
activations that need to be assigned to the primary and
secondary server in a collective, you are prompted to
reassign the licenses:

Reassign the licenses, and then click Apply again. 

To implement HA, configure interfaces to support failover and 
n-way buffering. Failover ensures that time-series data reaches
the Historian server even if one interface fails; n-way buffering
ensures that identical time-series data reaches each Historian
server in a collective.

To support failover, install a redundant copy of an interface on a 
separate computer. When one interface is unavailable, the 
redundant interface automatically starts collecting, buffering, 
and sending data to the Historian server. To support n-way 
buffering, configure the buffering service on interface 
computers to queue data independently to each Historian server 
in a collective. 

In some deployments, interfaces send outputs (that is, data from 
the Historian server) to the data source. With a proper 
configuration, failover considers the availability of the Historian 
server for outputs in addition to the availability of the interface. 

Configuring interfaces 
and buffering services 
for Historian server 
collectives 
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NOTE For more information, refer to the High-Availability-
Administrator-Guide_EN.pdf, chapter "Interfaces". 
For information on the location of the user 
documents, see "User documentation (page 17)". 

To open Collective Manager using your Start menu, enter 
Collective Manager and select the Collective Manager result. 

Opening Collective 
Manager on Windows 
Server 
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Appendix B 

Appendix B: Configuring the 
Advanced Server components 

NOTE For details on the types of licenses that activate the
Advanced Server components, see "Types of licenses 
activating the Advanced Server components (page 
60)". 

In this chapter you will learn about the following: 

• Configuring ACE (page 177)

• Configuring JDBC  (page 180)

• Configuring ODBC (page 189)

• Configuring OLEDB (page 190)

• Configuring OPC DA and HDA Servers (page 192)

• Configuring SQL Data Access Server (page 197)

• Configuring Web API Service (page 197)

In this section you will learn about the following: 

• Configure the ACE Manager (page 178)

• Verify the connection with the Historian server (page 179)

• Start the ACE Scheduler (page 179)

• Verify the ACE Scheduler status (page 179)

• Opening PI Ace Manager on Windows Server (page 180)

• Opening Services on Windows Server (page 180)

Configuring ACE 
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The procedures presented in the following sections contain only 
basic information on configuring the component. For detailed 
information on PI ACE, refer to the following documents: 

Document Location 

PI-ACE-2010-R2-SP2-
Release-Notes.pdf 

PI-ACE-2010-R2-
User-Guide-for-
Visual-Basic-
.NET_EN.pdf 

PI-ACE-2010-R2-
User-Guide-for-
Visual-Basic-
6_EN.pdf 

The following subfolders of the Common 
Files\Rockwell\Help folder in your Program 
Files (x86) directory: 
• FactoryTalk Historian SE <version>

Server\Advanced Server Options\
• FactoryTalk Historian SE <version>

Management Tools\Advanced Server
Options\

The availability of each folder depends on 
which FactoryTalk Historian suite you have 
installed on your computer. 

Word and help 
documents for PI 
ACE 

c:\Program Files (x86)\Rockwell 
Software\FactoryTalk 
Historian\PIPC\ACE\Help\ 

To configure ACE: 

1. Open PI ACE Manager. See Opening PI ACE Manager
on Windows Server (page 180).

2. The PI ACE Manager dialog box appears.
In the explorer tree, the detected Historian server is listed.

3. On the Server menu, click Add New Server, if there is no
server listed, or you want to add another one.
The Add Server dialog box appears.

4. Under PI Server Name, select the server that you want to
add, and then click OK.

Configure the ACE 
Manager 
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To verify the connection in the System Management Tools: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the Historian server
whose data you want to check.

3. Under System Management Tools, select Operation >
Network Manager Statistics.

4. In the right pane, find PIACEManager.exe.
The connection status (ConStatus) for this service should
be [0] Success.

To start the ACE Scheduler: 

1. Open Services (see Opening Services on Windows Server
on page 180).
The Services dialog box appears.

2. In the right pane, find the PI ACE 2.x Scheduler service.
3. Right-click the service, and then click Start.

The service is started and its status is changed to Started.

To verify the ACE Scheduler status in the ACE Manager: 

1. Open PI ACE Manager. See Opening PI ACE Manager
on Windows Server (page 180).
The PI ACE Manager dialog box appears.

2. In the explorer tree, expand the server item, if the
scheduler item is not visible.

3. Click the scheduler item.
A running PI ACE Scheduler is marked in green ( ), and
the current status is set to On.

Verify the connection 
with the Historian 
server 

Start the ACE 
Scheduler 

Verify the ACE 
Scheduler status 
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To verify the ACE Scheduler status in the System 
Management Tools: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the Historian server
whose data you want to check.

3. Under System Management Tools, select Operation >
Network Manager Statistics.

4. In the right pane, find PIACENetScheduler.exe.
The connection status (ConStatus) for this service should
be [0] Success.

To open PI ACE Manager using your Start menu, enter PI 
ACE Manager and select the PI ACE Manager result. 

To open Services using your Start menu, enter Services and 
select the Services result. 

For detailed information on JDBC, refer to the following 
documents: 

Opening PI ACE 
Manager on Windows 
Server  
Opening Services on 
Windows Server  

Configuring JDBC 
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Document Location 

PI-JDBC-Driver-2019-
Administrator-
Guide.pdf 

PI-JDBC-2019-
Release-Notes.pdf 

The following subfolders of the Common 
Files\Rockwell\Help folder in your Program 
Files (x86) directory: 
• FactoryTalk Historian SE <version>

Server\Advanced Server Options\ 
• FactoryTalk Historian SE <version>

Management Tools\Advanced Server
Options\

The availability of each folder depends on 
which FactoryTalk Historian suite you have 
installed on your computer. 

To verify the notifications status in the Administrative 
Tools: 

1. Open Services (see Opening Services on Windows Server
on page 180).
The Services dialog box appears.

2. In the right pane, find the PI Notifications Scheduler
service.

3. Make sure that its status reads Started Started or
Running (depending on the operating system version). If
it does not, right-click the service, and then click Start.

4. Right-click PI Notifications Scheduler, and then click
Properties.

5. Click the Log On tab. Make sure that the settings on this
tab allow the service to connect to the FactoryTalk
Historian SE server.

To create and configure a module database attribute: 

1. Open PI System Explorer. See Opening System Explorer
on Windows Server (page 189).
The PI System Explorer dialog box appears.

Verify the notifications 
services status 

Create and configure 
module database 
attributes 
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2. On the File menu, click Connections.
The Servers dialog box appears.

3. Right-click the name of your Asset Framework server, and
then click Connect.
The connection is indicated with a green dot on the AF
server icon.

4. Click Close.
5. Under Elements, click your Historian module database.
6. Click the Attributes tab.
7. Right-click in the tab area, and select New Attribute.

A new row is added for the new attribute, and the new
attribute's properties are displayed in the right pane.

8. In the Name text box, change the name of the attribute to
one of your choosing.

9. From the Value Type list, select the type of the attribute
value.

10. From the Data Reference list, select PI Point.
11. Click Settings.

The PI Point Data Reference dialog box appears.
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12. Click .
The Tag Search dialog box appears.

13. Type the name of the tag in the text box, or click Search.
14. Select the tag from the tag list, and then click OK.

The name of the selected tag appears in the Tag name text
box.

15. Click OK.
The tag you have selected is listed under Settings.
In this way, you have created a reference between the
database attribute and the Historian tag.
The newly created attribute is listed on the Attributes tab.

The attribute value reflects the value of the Historian tag 
that you have assigned to the attribute. 

Now you can create a notification rule (page 183) for the tag 
defined in the newly created attribute. 

To create a notification rule: 

NOTE For complete instructions on creating and
configuring notifications, please see PI-System-
Explorer-2018-SP3-User-Guide-EN.pdf. 

1. In PI System Explorer, select the element on which you
want to create notification rules.

Create a notification 
rule 
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2. From either the Notifications Rules tab or from an
existing event frame analysis, select Create a new
notification rule.

3. Enter a name for the new notification rule and (optionally)
select a category.

4. In the Trigger Criteria pane, specify the set of conditions
that causes a notification to be sent.

5. In the Subscriptions pane, select Manage Formats and
specify the format for notifications.

6. In the Subscriptions pane, select View/edit subscriptions
and specify the contacts to which notifications will be sent.

7. Test that the notification is triggered when an event occurs
that satisfies all of the trigger criteria specified.

Now you can assign licenses (page 184) to your notifications. 

To assign licenses to notifications: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. Log on to the FactoryTalk Directory.
3. In the Explorer tree of the FactoryTalk Administration

Console dialog box, go to System > Connections >
Historical Data.

4. Right-click Production Historian, and select Properties.
The Historian Server Connection Properties dialog box
appears.

5. Click the Point Sources tag.
6. Under Interface Type Allocation, type PINotifications-

InternalUse.
7. Under Limit, type the limit for the notification licenses.

Assign licenses to 
notifications 
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8. Click Apply.

This step is optional. If you do not restart the server, the license-
related information will be propagated in up to 20 minutes. 

To restart the Historian server: 

1. Stop the server:
a. Search for Stop FactoryTalk Historian SE in

Windows Search, right-click it, and then select Run
as administrator.
The server stopping process begins. The progress is
displayed in the Command Prompt window.

b. Wait until the server is stopped and the Command
Prompt window is closed.

2. Start the server:
a. Search for Start FactoryTalk Historian SE in

Windows Search, right-click it and then select Run as
administrator.
The server starting process begins. The progress is
displayed in the Command Prompt window.

b. Wait until the server is started and the Command
Prompt window is closed.

Restart the Historian 
server (optional) 
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To start a notification: 

1. Open PI System Explorer. See Opening System Explorer
on Windows Server (page 189).
The PI System Explorer dialog box appears.

2. In the navigation pane on the left, click Notifications.
3. Select the notification that you want to start.

4. On the toolbar, click .
The notification is started.

To verify the notifications status in the System Management 
Tools: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the Historian server
whose data you want to check.

3. Under System Management Tools, select Operation >
Network Manager Statistics.

4. In the right pane, find the following services:

• PINotificationsManager.exe

• PINotificationsHistoryProvider.exe
The connection status (ConStatus) for these services 
should be [0] Success. 

Start notifications 

Verify the notifications 
services status in 
System Management 
Tools 
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To verify the license consumption by the notification in the 
FactoryTalk Administration Console: 

1. Open FactoryTalk Administration Console. See
Opening FactoryTalk Administration Console on
Windows Server (page 100).
The FactoryTalk Administration Console dialog box
appears.

2. Log on to the FactoryTalk Directory.
3. In the Explorer tree of the FactoryTalk Administration

Console dialog box, go to System > Connections >
Historical Data.

4. Right-click Production Historian, and select Properties.
The Historian Server Connection Properties dialog box
appears.

5. Click the Point Sources tag.
Under Points in Use, the number of currently used
licenses is displayed.

NOTE For PI Notifications, each notification consumes
1 point in the FactoryTalk Administration 
Console. 

To verify the license consumption by the notification in the 
System Management Tools: 

Verify the license 
consumption by 
notifications 
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1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the Historian server
whose data you want to check.

3. Under System Management Tools, select Operation >
Licensing.

4. Expand your Historian server item.
5. Go to Resources > PointSourceLimit.PINotifications-

InternalUse.
The Amount Used property indicates the number of
licenses used for the notifications: it is 7 points per
notification.

NOTE The numbers provided for PI Notifications in
Total, Amount Used, and Amount Left are 
multiplied by 7 against those set in the 
FactoryTalk Administration Console. It is 
because each notification uses 7 points from the 
Rockwell pool. 
For example, if you set the limit for notifications 
to 50 in the FactoryTalk Administration Console, 
the Total number of allocated licenses in the 
System Management Tools will equal 350. 
Similarly, if you enable 50 notifications, the 
Amount Used value will equal 350. 
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To open System Explorer using your Start menu, enter PI 
System Explorer and select the System Explorer result.  

For detailed detailed information on ODBC, refer to the 
following documents: 

Opening System 
Explorer on Windows 
Server  
Configuring ODBC 
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Document Location 

PI-ODBC-2016-R2-
Administrator-
Guide.pdf 

PI-ODBC-2016-R2-
Release-Notes.pdf 

The following subfolders of the Common 
Files\Rockwell\Help folder in your Program 
Files (x86) directory: 
• FactoryTalk Historian SE <version>

Server\Advanced Server Options\
• FactoryTalk Historian SE <version>

Management Tools\Advanced Server
Options\

The availability of each folder depends on 
which FactoryTalk Historian suite you have 
installed on your computer. 

In this section you will learn about the following: 

• Verify the OLEDB Enterprise installation (page 191)

• Verify the connection with the Historian server (page 191)

• Verify the OLEDB MMC Snap-in status (page 192)

• Opening PI OLEDB MMC Snap-in on Windows Server
(page 192)

The procedures presented in the following sections contain only 
basic information on configuring the component. For detailed 
information on PI OLEDB, refer to the following documents: 

Configuring OLEDB 
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Document Location 

PI-OLEDB-Enterprise-
2019-User-Guide.pdf 

PI-OLEDB-Provider-
2019-Patch-1-
Release-Notes.pdf 

PI-OLEDB-Provider-
2019-User-Guide.pdf 

The following subfolders of the Common 
Files\Rockwell\Help folder in your Program 
Files (x86) directory: 
• FactoryTalk Historian SE <version>

Server\Advanced Server Options\
• FactoryTalk Historian SE <version>

Management Tools\Advanced Server
Options\

The availability of each folder depends on 
which FactoryTalk Historian suite you have 
installed on your computer. 

User guides and 
release notes for OLE 
DB Enterprise and 
OLE DB Provider 

<HistorianInstallationDirectory>\PIPC\OLED
B\Doc\ 

To verify the OLEDB Enterprise installation: 

1. Open Services (see Opening Services on Windows Server
on page 180).
The Services dialog box appears.

2. In the right pane, find the PI OLEDB Enterprise Agent
service.

3. Make sure that its status reads Started.

To verify the connection with the Historian Server in the 
OLEDB MMC Snap-in: 

1. Open PI OLEDB MMC Snap-in. See Opening PI
OLEDB MMC Snap-in on Windows Server (page 192).
The PIOLEDB window appears.

2. Under PI Servers, right-click the Historian server name,
and select Connect.
The PI Server Login dialog box appears.

Verify the OLEDB 
Enterprise installation 

Verify the connection 
with the Historian 
server 
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3. Type the user credentials, and then click OK.

TIP Check the authentication settings on your 
Historian server to find out whether or not you 
need to check the Use Windows NT Integrated 
security option for a successful logon. 

Once the connection is established, the Historian server 
tree node gets populated with its child items. 

To verify the OLEDB MMC Snap-in status in the System 
Management Tools: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the Historian server
whose data you want to check.

3. Under System Management Tools, select Operation >
Network Manager Statistics.

4. In the right pane, find mmc.exe. The connection status
(ConStatus) for this service should be [0] Success.

To open PI OLEDB MMC Snap-in using your Start menu, 
enter PI OLEDB MMC Snap-in and select the PI OLEDB MMC 
Snap-in result. 

In this section you will learn about the following: 

• Verify the status of the OPC DA and HDA servers (page
194)

Verify the OLEDB MMC 
Snap-in status 

Opening PI OLEDB 
MMC Snap-in on 
Windows Server 

Configuring OPC DA 
and HDA servers 
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• Connect to the OPC DA and HDA servers with the PI
OPC Client Tool (page 194)

• Opening PI OPC Tool on Windows Server (page 196)

For detailed information on OPC DA and HDA servers, refer to 
the following documents: 

• DA:

• PI_OPC_DA_Interface_ Failover_Manual_2.3.20.9.
docx

• PI-OPC-DA-Server- 2018-Patch-1---User-Manual.pdf

• PI-OPC-DA-Server- 2018-Patch-1---Release-Notes.pdf

• HDA:

• DCOM_Configuration_Guide_2.4.4.pdf

• PI_HDAServerConfigTool_ReleaseNotes.txt

• PI_HDATool_1.1.0.0_ReleaseNotes.txt

• PI_HDATool_1.1.0.0_UserGuide.docx

• PI-API-1.6.9-Release-Notes.htm

• PI-Buffer-Subsystem-2018-SP2-Patch1-Release-
Notes.pdf

• PI-OPC-HDA-Server-2016_Release-Notes.docx

• PI-OPC-HDA-Server-2016_User-Manual.docx

• PISDK-2018SP1-Patch-1-ReleaseNotes.pdf

You can find these documents in the following subfolders of the 
Common Files\Rockwell\Help folder in your Program Files 
(x86) directory: 

• FactoryTalk Historian SE <version> Server\Advanced
Server Options\

• FactoryTalk Historian SE <version> Management
Tools\Advanced Server Options\
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The availability of each folder depends on which FactoryTalk 
Historian suite you have installed on your computer. 

To verify the status of the OPC DA and HDA servers in the 
Administrative Tools: 

1. Open Services (see Opening Services on Windows Server
on page 180).
The Services dialog box appears.

2. In the right pane, find the following:

• DA: PI OPC DA Server

• HAD: PI OPC HDA Server for PI service
3. Make sure that its status reads Started.

To verify the status of the OPC DA and HDA servers in the 
System Management Tools: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the Historian server
whose data you want to check.

3. Under System Management Tools, select Operation >
Network Manager Statistics.

4. In the right pane, find the following:

• DA: OPCDA2_Service64.exe service

• HDA: PI_OSIHDA.exe service
The connection status (ConStatus) for these services 
should be [0] Success. 

To connect to the OPC DA and HDA servers with the PI 
OPC Client Tool: 

Verify the status of the 
OPC DA and HDA 
servers 

Connect to the OPC DA 
and HDA servers with 
the PI OPC Client Tool 
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1. Open PI OPC Tool. See Opening PI OPC Tool on
Windows Server (page 196).
The PIOPCTool window appears.

2. Under Server Name, select the following from the list,
and then click Connect.

• DA: OSISoft.OPCDA2.DA.1

• HDA: OSI.HDA.1
The PI_OSIHDA.exe console application is opened
and the connection is established.

NOTE On Windows Server 2012 R2 and Windows
Server 2012 the 
PI_OSIHDA.exe application will not start 
automatically. 
In order to start it, go to the 
%pihome%\PI_OSIOPC\ 
folder, and double-click the file there. 

3. Click OK in the confirmation message, and leave the
console window open.
In the PIOPCTool dialog box, under Connected servers,
the following server is listed.

• DA: OSISoft.OPCDA2.DA.1

• HDA: OSI.HDA.1

4. Click List Server's Tags.
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In the following box, the button a tree item with the name 
of your Historian server appears. 

5. Expand the item to see a complete list of the Historian
tags.

To open PI OPC Tool using your Start menu, enter PI OPC 
Tool and select the PI OPC Tool result. 

Opening PI OPC Tool 
on Windows Server  
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For detailed information on the SQL Data Access server, refer 
to the following documents: 

Document Location 

PI-SQL-Data-Access-
Server-(RTQP-
Engine)-2018-SP3-
Administrator-
Guide.pdf 

PI-SQL-Data-Access-
Server-(RTQP-
Engine)-2018-SP3-
Release-Notes.pdf 

The following subfolders of the Common 
Files\Rockwell\Help folder in your Program 
Files (x86) directory: 
• FactoryTalk Historian SE <version>

Server\Advanced Server Options\
• FactoryTalk Historian SE <version>

Management Tools\Advanced Server
Options\

The availability of each folder depends on 
which FactoryTalk Historian suite you have 
installed on your computer. 

To verify the SQL Data Access Server status: 

1. Open Services (see Opening Services on Windows Server
on page 180).
The Services dialog box appears.

2. In the right pane, find the PI SQL Data Access Server
service.

3. Make sure that its status reads Started.

In this section you will learn about the following: 

• Verify the Web API services status in Services (page 198)

• Verify the Web API services status in Internet Explorer
(page 198)

• Open PI Web API Admin Utility on Windows Server
(page 200)

Configuring SQL Data 
Access Server 

Verify the SQL Data 
Access Server status 

Configure Web API 
Service 
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• Open PI Web API Admin Utility on Windows Server
(page 200)

The procedures presented in the following sections contain only 
basic information on configuring the component. For detailed 
information on the Web API service, refer to the following 
documents: 

Document Location 

PI-Web-API-2019-SP1- 
Release-Notes.pdf 

PI-Web-API-2019-User-
Guide.pdf 

The following subfolders of the Common 
Files\Rockwell\Help folder in your 
Program Files (x86) directory: 
• FactoryTalk Historian SE <version>

Server\Advanced Server Options\
• FactoryTalk Historian SE <version>

Management Tools\Advanced Server
Options\

The availability of each folder depends on 
which FactoryTalk Historian suite you have 
installed on your computer. 

To verify the Web API Server status in Services: 

1. Open Services (see Opening Services on Windows Server
on page 180).
The Services dialog box appears.

2. In the right pane, find the following services:

• PI Web API 2019 SP1

• PI Web API 2019 SP1 Crawler
3. Make sure that their statuses read Started or Running

(depending on the operating system version). If they do
not, right-click each service, and then click Start.

To verify the Web API Server status in Internet Explorer: 

Verify the Web API 
services status in 
Services 

Verify the Web API 
services status in 
Internet Explorer 
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1. Open PI Web API Admin Utility. See Open PI Web API
Admin Utility on Windows Server (page 200).
The Change PI Web API Installation Configurations
dialog box appears.

2. Go through the configuration until the Configure the PI
Indexed Search Crawler Submit Url page appears.

3. Copy the link displayed on the page.
4. Open Internet Explorer.
5. Add the page to Compatibility View:

a. On the toolbar, click , and then click Compatibility
View Settings. The Compatibility View Settings
window appears.

b. Under Add this website, paste the link from PI Web
API Admin Utility.

c. Click Add. The link appears under Websites you've
added...

d. Click Close.
6. Close Internet Explorer, and then open it again.
7. In the address bar, paste the link from PI Web API Admin

Utility. You may need to type your username and
password to access the page.
If the Web API services are running, you will see a page
similar to the following:

Otherwise, you will see a This page can't be displayed 
message. For details on starting the services, see "Verify 
the Web API services status in Services" (page 198). 
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If you start the Web API services, repeat the steps 
presented in this section, and the Web API page still does 
not appear, see the services documentation for 
troubleshooting. For details on the Web API 
documentation, see "Configure Web API Service" (page 
197). 

To open PI Web API Admin Utility using your Start menu, 
enter PI Web API Admin Utility and select the PI Web API 
Admin Utility result. 

Open PI Web API 
Admin Utility on 
Windows Server 
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Appendix C 

Appendix C: Configuring and 
upgrading Live Data interface 
redundancy 

For detailed information on the installation and configuration of 
the interface redundancy, refer to KB article 59932. 

For detailed information on upgrading the interface redundancy, 
see KB article 1032534. 

Overview 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/59932
https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/1032534
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Appendix D 

Appendix D: FactoryTalk View 
SE TrendX and TrendPro 

The FactoryTalk View TrendX and TrendPro display objects 
support FactoryTalk Historian SE server as a data source. In this 
chapter you will learn how to configure FactoryTalk View 
TrendX and TrendPro to trend the data points (tags) from 
FactoryTalk Historian SE server. A trend is a visual 
representation or a chart of real-time or historical data. It 
provides a way to track plant activity as it is happening. 

Before you start using the TrendX/TrendPro object with your 
FactoryTalk Historian SE server, do the following: 

• Install the Historian connectivity from the FactoryTalk
View SE installation media on the FactoryTalk View SE
Server, Studio, and client computers.

• Either use a Windows user (page 90) mapped in the
System Management Tools or create a trust (page 206)
between the device on which you will use the
TrendX/TrendPro object and the FactoryTalk Historian SE
server that will be used as the data source of the object.

NOTE: The preferred connection method is through
Windows users mapped to Historian groups. If 
the HMI users are not Windows users, then 
configure a trust to allow connectivity. 

• Add the FactoryTalk Historian SE server to the
FactoryTalk Directory (page 98).

• Make sure both the client and the FactoryTalk Historian
SE server point to the same FactoryTalk Directory (page
31).
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TIP For more information on FactoryTalk View 
TrendX and TrendPro, refer to the product 
documentation. 

If you intend to use the FactoryTalk View TrendX/TrendPro 
display object to trend data points (tags) from the FactoryTalk 
Historian SE server, you need to establish a security connection 
between the device on which you use the TrendX/TrendPro 
object (e.g., a computer with FactoryTalk View running) and 
the FactoryTalk Historian SE server. You can achieve it by 
creating a trust between the IP address of the device and the 
FTHOperator user of the FactoryTalk Historian SE server 
security model. 

NOTE For more information on the FactoryTalk
Historian SE server users, see "Historian security 
components and their privileges (page 83)". 

To create a security trust for the FactoryTalk View 
TrendX/TrendPro object on the computer with the 
FactoryTalk Historian SE server installed: 

1. Open System Management Tools. See Opening System
Management Tools on Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Collectives and Servers, select the FactoryTalk
Historian SE server, for which you want to create the trust.

3. Under System Management Tools, select Security >
Mappings & Trust.

4. Go to the Trusts tab.

5. On the toolbar, click the arrow next to , and select 
Advanced. 

Creating security trusts 
for the FactoryTalk 
View TrendX/TrendPro 
display object 
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6. In the Add New Trust dialog box, provide the following
information:

Item name Description 

Trust Name Type a name of the trust. 
Server Name Select from the list the FactoryTalk 

Historian SE server for which you want to 
create the trust. 

IP Address Type the IP address of the device on which 
you will use the FactoryTalk View 
TrendX/TrendPro objects. 

NetMask Type 255.255.255.255. 
PI Identity 1. Click .

The Select PI Identity, PI Group, or PI
User dialog box appears.

2. From the Type list, select PI Users.
3. From the list, select FTHOperator, and

click OK.
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7. Click OK. The new trust appears in the Trusts tab.

Now you can start using the FactoryTalk View 
TrendX/TrendPro object with your FactoryTalk Historian SE 
server. 

To configure trend properties for an existing application: 

1. Open FactoryTalk View Studio.
2. In the Application Type Selection dialog box, select the

type of the application, and click Continue.
3. In the application dialog box, select the existing

application name, the language for the application, and
click Open.

Configuring trend 
properties for TrendX 
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4. In the Explorer tree, expand an HMI project, and select a
display.

5. Right-click the display and select Open. The display
canvas appears in the right pane of the dialog box.

6. Click in the canvas to display additional menu items in the
menu bar.

7. On the Objects menu, click Advanced > Trend.The
object type name appears next to the mouse pointer.

8. Place the mouse pointer on the display canvas, press and
hold the left mouse button and drag the mouse pointer to
create a trend.

9. Double-click the trend object.
The Trend Properties dialog box appears.

NOTE For more information on the trend properties,
refer to the FactoryTalk View SE Help. To access 
it, click Help in the Trend Properties dialog box. 

10. In the General tab, select either of the following options
from the Data Server list:

Item name Description 

Real-time data 
server 

Retrieves data from the snapshot 
subsystem. This option is preferred for 
points that change infrequently, e.g., 
setpoints. 

Poll historical 
data 

Retrieves data from the archive files. This 
option is preferred for points that change 
faster than a second. 

11. In the Pens tab, select Historian Server from the Pen
Source list.

12. Click Add Pen(s).
The Add Pen Configuration dialog box appears.

NOTE You can add new or existing FactoryTalk
Historian data points (tags) in pen for trending - 
one pen per tag. 
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13. From the FT Historian Server list, select the FactoryTalk
Historian SE server for which you have created the trust
(page 206).

NOTE The TrendX object supports pens that come
from different FactoryTalk Historian SE servers. 
For example, you can add a Pen 1 tag from the 
Server A and a Pen 2 tag from the Server B. The 
tag names must be unique. 

14. In the Enter or Select Tag text box:

• Type the name of the data point (tag) you want to add,
or

• Search for a tag by clicking .
The Tag Search dialog box appears.

TIP For information on how to use the Tag 
Search dialog box, click Help in the dialog 
box. 

15. Once you have selected the tag, click OK.
16. In the Add Pen Configuration dialog box, click Add.

The tag name is validated.

• If validation fails, a relevant message appears. Correct
the tag name and click Add again.

• If validation succeeds, the tag is added to the list box,
and the Enter or Select Tag text box is cleared.

17. Click OK.
The tag is displayed in the Pens tab of the Trend
Properties dialog box.

18. Click OK.
The tag is added to the trend object in the display.

19. Click  on the toolbar to test the display.
The trend starts displaying data from the selected tag.

To configure trend properties for an existing application: Configuring trend 
properties for TrendPro 
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1. Open FactoryTalk View Studio.
2. In the Application Type Selection dialog box, select the

type of the application, and click Continue.
3. In the application dialog box, select the existing

application name, the language for the application, and
click Open.

4. In the Explorer tree, expand a HMI project, and expand
Graphics.

5. Right-click Displays and select New. The display canvas
appears in the right pane of the dialog box.

6. Click in the canvas to display additional menu items in the
menu bar.

7. On the Objects menu, click Trending > TrendPro. The
object type icon appears next to the mouse pointer.

8. Place the mouse pointer on the display canvas, press and
hold the left mouse button and drag the mouse pointer to
create a trend.

9. The TrendPro Properties dialog box appears. If not,
double-click the trend object.

NOTE For more information on the TrendPro
properties, refer to the FactoryTalk View SE 
Help. To access it, click Help in the Trend 
Properties dialog box. 

10. In the General tab, define which trend settings are
available to operators at runtime. To prevent operators
from changing these options, this tab is not available at
runtime. The following table defines the available settings.

Settings Description 

Trend Setup Click this button to open the Properties 
dialog box and configure the detailed trend 
appearances and behaviors at runtime. 
The Properties dialog box is also available at 
runtime if the Context menu option is 
enabled. 
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Settings Description 
Chart Specify which trend panes are displayed and 

whether the context menus are available to 
operators at runtime. 
The panes include Tag explorer, Toolbar, 
Timebar, Context menu, Tag list, and 
Alarm event list. You can also specify 
whether to collapse the tag list or alarm 
event list when the trend first runs. 

Properties 
Dialog 

Specify which trend property tabs are 
available to operators at runtime. 
By default, the runtime Properites dialog 
box includes the General and Traces tabs. 
The General tab includes Time Period, 
Application, Chart, Retrieval, X-Axis, and 
Shape. 

11. Use the Common tab in the TrendPro Properties dialog
box to set up the properties common to all graphic objects,
such as size and position.

12. In the General tab, click Trend Setup. The Properties
dialog box appears.

13. In the Traces tab, select Trace for Show.
14. Click the + button in the toolbar. The Select Item dialog

box appears.
15. Select Tag for Add as. The existing application is listed

under Items.
16. Select Historical Data > Production Historian.
17. Select the tags you want to add from the items list
18. Click OK.

The tag is displayed in the Trace tab of the Properties
dialog box.

19. Click Close to close the Properties dialog box, and then
click OK to close the TrendPro Properties dialog box.
The tag is added to the TrendPro object in the display.
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20. Click  on the toolbar to test the display.
The trend starts displaying data from the selected tag.
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Appendix E 

Appendix E: Upgrading 
FactoryTalk Historian SE 

In this chapter you will learn about upgrade procedures for 
individual suites of FactoryTalk Historian SE. 

The upgrade procedure differs depending on the version of 
FactoryTalk Historian SE you are currently using. See each 
procedure for details. 

NOTE Before you upgrade any components of FactoryTalk
Historian SE, refer to the Release Notes for the up-to-
date information on the upgrade procedures. 

The upgrade procedure differs depending on the FactoryTalk 
Historian server version that you currently use: 

For this 
Historian 
server version 

Do the following 

• 2.10
• 2.20

1. Migrate your Historian server to the version
3.01.
Note: For more information on the migration
process, refer to KB article 491889 on the
Rockwell Automation Knowledgebase site.

2. Perform the following steps.

3.0 and higher Perform the following steps. 

Upgrading the 
FactoryTalk Historian 
server 

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/491889
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NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

To upgrade the FactoryTalk Historian server: 

1. Upgrade FactoryTalk Services.
For details, see "Install FactoryTalk Services (page 28)".

2. Stop the FactoryTalk Historian server.

TIP To learn how to stop the Historian server, see 
"Stopping the Historian server on Windows 
Server (page 217)". 

3. In Services (see Opening Services on Windows Server on
page 180), find and stop the following services, if they are
present in the system and running.
The service listed as Required must be stopped manually
before the upgrade. The services listed as Optional can
either be stopped manually or automatically during the
installation. In this case, you will be asked to confirm the
action of stopping them. The upgrade will not be
performed without stopping these services.

• Required:

• OPC interfaces

• Optional:

• FTHConnector

• FTLDIntAgent

• All FTLD interface services (for example FTLD1,
FTLD2, etc.)

• IIS Admin Service

• PI Base Subsystem

• PI Network Manager with PI Message Subsystem
(stopped automatically)



Appendix E: Upgrading FactoryTalk Historian SE Appendix E 

Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 217 

• PI Performance Monitor

TIP To stop a service, right-click it, and then 
click Stop. 

4. Wait until all the services are stopped.
5. Install the FactoryTalk Historian server:

See "Install the FactoryTalk Historian SE server (page
44)" for details.

To stop the Historian server... 

1. Using your Start menu, enter Stop.
Search results are displayed on the screen.

2. Search for Stop FactoryTalk Historian SE in Windows
Search, right-click it, and then select Run as
administrator.
The server stopping process begins. The progress is
displayed in the Command Prompt window.

3. Wait until the server is stopped and the Command Prompt
window is closed.

The upgrade will be performed according to the following rules: 

• It will be installed on the same installation drive that you
originally chose for any of the FactoryTalk Historian SE
components.

• It will use the same installation mode that you selected
during the first installation of FactoryTalk Historian Asset
Framework. See "Installation modes for FactoryTalk
Historian Asset Framework (page 36)" for details.

• It will use the same configuration that you set for the
previous version of FactoryTalk Historian Asset
Framework.

The upgrade procedure differs depending on the FactoryTalk 
Historian server version that you currently use: 

Stopping the Historian 
server on Windows 
Server  

Upgrading FactoryTalk 
Historian Asset 
Framework 
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For this 
Historian 
server version 

Do the following 

• 2.10
• 2.20

1. Migrate your Historian server to the version
3.01.
Note: For more information on the migration
process, refer to KB article 491889 on the
Rockwell Automation Knowledgebase site.

2. Perform the following steps.

3.0 and higher Perform the following steps. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

Before you begin: 

1. To avoid losing any data, back up your PIFD database.
For details, see the PI-AF-Installation-and-Upgrade-
Guide-EN, chapter "PI AF server maintenance".

TIP For information on the location of the 
documents, see "User documentation (page 
17)". 

2. Stop PI AF Application Service using Services from the
Administrative Tools folder in Control Panel, if the
service exists.
For details on how to open the Services window, see
"Opening the Services window on Windows Server (page
71)".

NOTE If you do not stop the service manually, the
service will be stopped automatically during the 
installation. You will be asked to confirm the 
action of stopping it. The upgrade will not be 
performed without stopping the service. 

3. Upgrade FactoryTalk Services.

https://rockwellautomation.custhelp.com/app/answers/answer_view/a_id/491889
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For details, see "Install FactoryTalk Services (page 28)". 

To upgrade FactoryTalk Historian Asset Framework: 

NOTE You need administrative rights to perform the
upgrade steps. 

TIP The descriptions presented in the following 
instruction illustrate typical installation or upgrade 
steps. Individual steps may differ though, depending 
on the actual system configuration. 

1. Run the FactoryTalk Historian SE installation wizard
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Install
FactoryTalk Historian Asset Framework > Install
FactoryTalk Historian AF Server.
If detected, a list of prerequisites to be met may appear, as
presented in the following example:

In such a case, follow the instructions displayed on the 
screen, close the installation wizard window, and then start 
the installation wizard again. 

3. In the welcome screen of the Asset Framework Suite
installation wizard, click Next.

4. In the License agreement screen, accept the license
agreement and click Next.

5. In the Review Component Installation screen, verify that
the components you want installed are listed and click
Next.

6. In the Destination Drive screen, select the drive where you
want AF to be installed and click Next.

7. In the Installation Progress screen, click Install. A
progress bar displays your installation progress.
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8. If the release notes display, close the release notes and
continue with the installation.

9. Click Finish. If you want to view the log, check Show the
installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 

NOTE If you have upgraded Asset Framework without
executing the database scripts, see "Manually 
create or upgrade the AF SQL database (page 
71)". 

To verify if you have upgraded Asset Framework 
successfully: 

1. On the computer with FactoryTalk Historian SE server
installed, search for and open System Management
Tools. See Opening System Management Tools on
Windows Server (page 71).
The System Management Tools dialog box appears.

2. Under Servers, select the server for which you want to
check the AF upgrade status.

3. Under System Management Tools, go to Operation >
AF Link.
A successful upgrade will be indicated with the InSync
status and a green symbol next to the server name.

NOTE The synchronization process may take several
minutes. 

4. If the server has not synchronized, restart the PI AF Link
Subsystem service, and check the synchronization again.

Verifying the Asset 
Framework upgrade 
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The upgrade procedure differs depending on the version of 
FactoryTalk Historian SE Management Tools that you currently 
use: 

For this 
version of 
FactoryTalk 
Historian SE 
Management 
Tools 

Do the following 

• 2.10
• 2.20

1. Back up your discovery rule and tag attribute
XML files, if you have defined them.

2. Remove FactoryTalk Historian SE Management
Tools from your computer.

3. Perform the following steps.

3.0 and higher Perform the following steps. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

To upgrade FactoryTalk Historian SE Management Tools: 

1. In Services (see Opening Services on Windows Server on
page 180), find and stop the following services, if they are
present in the system and running.
The service listed as Required must be stopped manually
before the upgrade. The services listed as Optional can
either be stopped manually or automatically during the
installation. In this case, you will be asked to confirm the
action of stopping them. The upgrade will not be
performed without stopping these services.

• Required:

• OPC interfaces

Upgrading FactoryTalk 
Historian SE 
Management Tools 
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• Optional:

• FTHConnector

• FTLDIntAgent

• All FTLD interface services (for example FTLD1,
FTLD2, etc.)

• IIS Admin Service

• PI Base Subsystem

• PI Network Manager with PI Message Subsystem
(stopped automatically)

• PI Performance Monitor

TIP To stop a service, right-click it, and then 
click Stop. 

2. Wait until all the services are stopped.
3. Install the FactoryTalk Historian SE Management Tools.

See "Install FactoryTalk Historian SE Management Tools
(page 50)" for details.

The upgrade procedure differs depending on the version of 
FactoryTalk Historian Live Data Interface that you currently 
use: 

For this 
version of 
FactoryTalk 
Historian Live 
Data 
Interface 

Do the following 

• 2.10
• 2.20

1. Back up your discovery rule and tag attribute
XML files, if you have defined them in
FactoryTalk Historian SE Rule Editor.

2. Remove FactoryTalk Historian Live Data
Interface from your computer.

3. Perform the following steps.

Upgrading FactoryTalk 
Historian Live Data 
Interface 
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For this 
version of 
FactoryTalk 
Historian Live 
Data 
Interface 

Do the following 

3.0 and higher Perform the following steps. 

NOTE To learn about prerequisites regarding specific
versions of the applications, see "Learn about product 
compatibility for installing or upgrading FactoryTalk 
Historian suites (page 24)". 

To upgrade FactoryTalk Historian Live Data Interface: 

1. In Services (see Opening Services on Windows Server on
page 180), find and stop the following services, if they are
present in the system and running.
The service listed as Required must be stopped manually
before the upgrade. The services listed as Optional can
either be stopped manually or automatically during the
installation. In this case, you will be asked to confirm the
action of stopping them. The upgrade will not be
performed without stopping these services.

• Required:

• OPC interfaces

• Optional:

• FTHConnector

• FTLDIntAgent

• All FTLD interface services (for example FTLD1,
FTLD2, etc.)

• IIS Admin Service

• PI Base Subsystem
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• PI Network Manager with PI Message Subsystem
(stopped automatically)

• PI Performance Monitor

TIP To stop a service, right-click it, and then click 
Stop. 

2. Wait until all the services are stopped.
3. Install the FactoryTalk Historian Live Data Interface.

See "Install the FactoryTalk Historian Live Data Interface
(page 47)" for details.

4. Verify that buffering is working.
For details, see "Verify that buffering is working
correctly" (page 141).

5. Verify that points are being collected.
For details, see "Verify that points are being collected"
(page 131).
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Appendix F 

Appendix F: Removing 
FactoryTalk Historian SE 

IMPORTANT Do not remove FactoryTalk Historian SE unless
you have decided not to use Historian SE server or 
you are resetting your FactoryTalk Historian plant 
floor operations. Removing FactoryTalk Historian 
SE will result in the loss of data. 

Before you begin, stop Batch Interface if it is present in the 
system and running. 

To remove FactoryTalk Historian SE, choose one of the 
following methods: 

• Using the Start screen or the Start menu (page 226).

• Using Control Panel (page 227).

• Using the FactoryTalk Historian SE installation media
(page 227).

During the removal of FactoryTalk Historian SE from your 
computer, all the files from the current and previous versions of 
the product that are still located on your computer are removed, 
starting from the newest version that you have installed.  

After the newest version is removed, a message similar to the 
following message appears before each previous version of the 
suite is about to be removed: 



Appendix F Appendix F: Removing FactoryTalk Historian SE 

226 Rockwell Automation Publication HSE-IN025F-EN-E–September 2020 

Each message contains the name of the suite that is about to be 
removed and its version number. 

Click OK to complete the removal process. 

NOTES • The FactoryTalk Historian removal wizard
for FactoryTalk Historian SE Management 
Tools, FactoryTalk Historian Live Data 
Interface, and FactoryTalk Historian Asset 
Framework doesn't remove the components 
that are shared by other FactoryTalk 
products. If you want to remove them as 
well, you need to do it manually using 
Control Panel. 

• The FactoryTalk Historian removal wizard
for FactoryTalk Historian SE Server removes
all the components that are shared by PI
applications.

The removal process differs depending on the version of the 
operating system that you use. 

To remove a suite using the Start menu 

1. Enter Uninstall.
2. Choose the "Uninstall..." item of the FactoryTalk Historian

suite that you want to remove from your computer, for

Removing a suite using 
the Start screen or the 
Start menu 
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example, Uninstall FactoryTalk Historian Asset 
Framework. 
The removal wizard appears. 

3. On the wizard pages, click Next and then Uninstall to
start the removal process.

4. Follow the on-screen instructions to complete the process.

The removal process differs depending on the version of the 
operating system that you use. 

To remove a suite using Control Panel 

1. From your Start menu, access the Control Panel.
2. Do one of the following depending on your environment:

• Click Programs and Features.

• Under Programs, click Uninstall a program.
Programs and Features appear. 

3. Under Uninstall or change a program, select the name of
the FactoryTalk Historian suite that you want to remove
from the computer, and then click Uninstall/Change.
The removal wizard appears.

4. On the wizard pages, click Next and then Uninstall to
start the removal process.

5. Follow the on-screen instructions to complete the process.

To remove a suite using the FactoryTalk Historian SE 
installation media: 

1. Run the FactoryTalk Historian SE installation wizard.
2. On the welcome page of the installation wizard, click

Install FactoryTalk Historian Site Edition > Uninstall
FactoryTalk Historian Site Edition > Uninstall
FactoryTalk Historian Server.
The names of all the suites that you can remove will be
active.

Removing a suite using 
Control Panel 

Removing a suite using 
the installation media 
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In this example, you will remove FactoryTalk Historian 
Asset Framework. 

3. In the welcome screen of the selcted suite, click Next.
4. Click Uninstall to begin the removal.
5. Click Finish. If you want to view the log, check Show the

installation log before you click Finish.

TIP The installation log, fth_installer.log, is 
available in the following location: 
[Drive letter]:\Program Files\Rockwell 
Software\FactoryTalk Historian\Installation 
Manager\<Name of the Historian 
suite>\FTHInstallerLogs\<Date and Time of 
the Installation>. 
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Appendix G 

Technical support and resources 

Rockwell Automation provides 24/7 dedicated technical support 
internationally. 

You can read complete information about technical support 
options, and access all of the following resources at the 
Rockwell Automation Support Web site 
(http://www.rockwellautomation.com/support/). 

When you contact Rockwell Automation Technical Support, 
please provide: 

• Product name, version, and/or build numbers.

• Computer platform (CPU type, operating system, and
version number).

• The time that the difficulty started.

• The message log(s) at that time. Consult your product
documentation on the location of the message log files.

To find version and build numbers for each Historian Server 
subsystem (which vary depending on installed upgrades, 
updates, or patches), use either of the following methods: 

To check the numbers with System Management Tools 
(SMT): 

1. Search for System Management Tools in Windows
Search, and then open it. See Opening System
Management Tools on Windows Server (page 71).

2. Under Collectives and Servers, select the name of the
server you want to check.

Before you call or write 
for help 

Find the version and 
build numbers 

http://www.rockwellautomation.com/support/
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3. Under System Management Tools, select Operation >
PI Version.
The Version in Memory and Version on Disk columns
display information on versions of all the server
subsystems.

If you do not have System Management Tools installed, open a 
command prompt, change to the pi\adm directory, and type 
piversion -v. To see individual version numbers for each 
subsystem, change to the pi\bin directory and type the 
subsystem name followed by the option -v (for example, 
piarchss.exe -v). 

To view platform specifications, press Windows + R to open 
the Run dialog box, and then type msinfo32.exe. 

View computer 
platform information 
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Rockwell Automation Support 

Rockwell Automation provides technical information on the Web to assist you in using its products. 
At http://www.rockwellautomation.com/support/ you can find technical and application notes, sample code, and 
links to software service packs. You can also visit our Support Center at https://rockwellautomation.custhelp.com/ 
for software updates, support chats and forums, technical information, FAQs, and to sign up for product 
notification updates. 

In addition, we offer multiple support programs for installation, configuration, and troubleshooting. For more 
information, contact your local distributor or Rockwell Automation representative, or visit 
http://www.rockwellautomation.com/services/online-phone. 
 

Installation Assistance 

If you experience a problem within the first 24 hours of installation, review the information that is contained in this 
manual. You can contact Customer Support for initial help in getting your product up and running. 
 

United States or Canada 1.440.646.3434 

Outside United States 
or Canada 

Use the Worldwide Locator at 
http://www.rockwellautomation.com/rockwellautomation/support/overview.page, or contact your 
local Rockwell Automation representative. 

New Product Satisfaction Return 

Rockwell Automation tests all of its products to help ensure that they are fully operational when shipped from the 
manufacturing facility. However, if your product is not functioning and needs to be returned, follow these 
procedures. 
 

United States Contact your distributor. You must provide a Customer Support case number (call the phone number 
above to obtain one) to your distributor to complete the return process. 

Outside United States Please contact your local Rockwell Automation representative for the return procedure. 

Documentation Feedback 

Your comments will help us serve your documentation needs better. If you have any suggestions on how to 
improve this document, complete this form, publication RA-DU002, available at 
http://www.rockwellautomation.com/literature/. 

http://www.rockwellautomation.com/rockwellautomation/distributor-locator/sales-locator.page
http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf


Rockwell Automation maintains current product environmental information on its website at 
http://www.rockwellautomation.com/rockwellautomation/about-us/sustainability-ethics/product-environmental-
compliance.page. 


	FactoryTalk Historian SE Installation and Configuration Guide
	Preface
	Table of Contents
	1 - Overview
	FactoryTalk Historian installation package
	Typical architecture
	System requirements
	User documentation
	Location of the user documentation
	On the installation media
	On the local hard drive
	In the Start menu



	2 - Pre-installation tasks
	Synchronize time settings on FactoryTalk Historian system computers
	Disable the Windows time zone (TZ) environment variable
	Learn about installation-related recommendations
	Learn about product compatibility for installing or upgrading FactoryTalk Historian suites

	3 - Installing FactoryTalk Historian
	Install Core components
	Install Microsoft SQL Server
	Install FactoryTalk Services
	Locate the FactoryTalk Directory server computer


	Install FactoryTalk Historian suites
	Install FactoryTalk Historian Asset Framework
	Installation modes for FactoryTalk Historian Asset Framework
	Install the FactoryTalk Historian Asset Framework server

	Install the FactoryTalk Historian SE server
	Install the FactoryTalk Historian Live Data Interface (optional)
	Install the FactoryTalk Historian SE Management Tools (optional)
	Install the FactoryTalk Historian Analysis Service
	Install Notifications Service
	Install additional Historian components

	About installing Microsoft® .NET Framework
	Advanced Server components (optional)
	Types of licenses activating the Advanced Server components
	Prerequisites for installing the Advanced Server components
	Install ACE
	Install JDBC
	Install ODBC
	Install OLEDB Enterprise
	Install OLEDB Provider
	Install OPC DA and OPC HDA Server
	Install SQL Data Access Server


	4 - Post-installation tasks
	View the installation log file
	Verify that Historian services are running
	Verify that the Historian server is updating data for default tags
	Opening System Management Tools on Windows Server
	Manually create or upgrade the AF SQL database
	Create the AFServers local group on the AF application service computer
	Execute the SQL scripts to create and populate the AF SQL database
	Modify the AF application service connect string
	Configure the AF application service to point to a different AF SQL database

	Perform the MDB to AF synchronization
	Verify the MDB to AF synchronization
	Disable virus scanning
	Change logon account settings for FactoryTalk Historian Analysis Service

	5 - Configuring FactoryTalk Historian
	Activating the Historian server
	Securing the Historian server
	Historian security components and their privileges
	Managing Historian security components
	Creating security mappings
	Managing security of the Historian server database

	Manually configuring Windows Firewall for FactoryTalk Historian
	Checking the location of FactoryTalk Historian Live Data Interface

	Configuring the Historian server
	Adding the server to the FactoryTalk Directory
	Verifying the FactoryTalk Historian Live Data Local Interface
	Opening FactoryTalk Administration Console on Windows Server
	Managing licenses
	Types of licenses
	Learn how licenses are distributed between license pools
	Distributing licenses
	Assigning license activations to the Historian server
	Allocating licenses to interface types (or point sources)
	Viewing allocated licenses

	Configuring points
	Adding individual data points manually
	Adding multiple data points automatically

	View current and archive data
	View current data
	View archive data

	Archives and backups
	Restart the FactoryTalk Historian SE server

	Configure the data server
	Configure Historian interface connections
	Configure FactoryTalk Historian Live Data Interface
	Create security mappings for remote interfaces
	Set up a connection between the FTLD interface and the FactoryTalk Historian SE server computers
	Register Live Data interfaces
	View the status of Live Data interface services
	Verify that points are being collected
	Enable buffering
	Verify that there is a buffering trust created
	Run the first-time buffering configuration
	Specify the FactoryTalk Historian SE that will receive the buffered data
	Configure the FTLD service
	Verify that buffering is working correctly


	Enabling Excel add-ins for FactoryTalk Historian DataLink
	Activating Excel COM add-ins for FactoryTalk Historian DataLink
	Recording messages using FactoryTalk Diagnostics
	Understand message parameters
	Viewing messages
	Opening Event Viewer on Windows Server


	6 - Troubleshooting FactoryTalk Historian
	Using FactoryTalk Historian ME modules with FactoryTalk Security
	Verifying the Windows Administrators privileges
	Resolving error and warning messages
	General
	Error: system is a PINs node
	Error: server not found
	Error: failure to retrieve interface information

	No connection to FactoryTalk Directory
	Schema creation
	Folders creation

	Firewall-related errors
	Configuring Windows Firewall with WFCU



	A - Configuring Historian servers in high availability mode
	High availability (HA) architecture
	Working with server collectives
	Creating server collectives
	Configure Windows Firewall for collectives
	Verifying communication between server collective members
	Verifying replication of configuration changes in the primary server
	Assigning license activations to server collectives
	Configuring interfaces and buffering services for Historian server collectives
	Opening Collective Manager on Windows Server

	B - Configuring the Advanced Server components
	Configuring ACE
	Configure the ACE Manager
	Verify the connection with the Historian server
	Start the ACE Scheduler
	Verify the ACE Scheduler status
	Opening PI ACE Manager on Windows Server
	Opening Services on Windows Server

	Configuring JDBC
	Verify the notifications services status
	Create and configure module database attributes
	Create a notification rule
	Assign licenses to notifications
	Restart the Historian server (optional)
	Start notifications
	Verify the notifications services status in System Management Tools
	Verify the license consumption by notifications
	Opening System Explorer on Windows Server

	Configuring ODBC
	Configuring OLEDB
	Verify the OLEDB Enterprise installation
	Verify the connection with the Historian server
	Verify the OLEDB MMC Snap-in status
	Opening PI OLEDB MMC Snap-in on Windows Server

	Configuring OPC DA and HDA servers
	Verify the status of the OPC DA and HDA servers
	Connect to the OPC DA and HDA servers with the PI OPC Client Tool
	Opening PI OPC Tool on Windows Server

	Configuring SQL Data Access Server
	Verify the SQL Data Access Server status

	Configure Web API Service
	Verify the Web API services status in Services
	Verify the Web API services status in Internet Explorer
	Open PI Web API Admin Utility on Windows Server


	C - Configuring and upgrading Live Data interface redundancy
	Overview

	D - FactoryTalk View SE TrendX and TrendPro
	Creating security trusts for the FactoryTalk View TrendX/TrendPro display object
	Configuring trend properties for TrendX
	Configuring trend properties for TrendPro

	E - Upgrading FactoryTalk Historian SE
	Upgrading the FactoryTalk Historian server
	Stopping the Historian server on Windows Server

	Upgrading FactoryTalk Historian Asset Framework
	Verifying the Asset Framework upgrade

	Upgrading FactoryTalk Historian SE Management Tools
	Upgrading FactoryTalk Historian Live Data Interface

	F - Removing FactoryTalk Historian SE
	Removing a suite using the Start screen or the Start menu
	Removing a suite using Control Panel
	Removing a suite using the installation media

	G - Technical support and resources
	Before you call or write for help
	Find the version and build numbers
	View computer platform information

	Index

	Back cover



